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Abstract

ANAGLYPH IS CONSIDERED as an inexpensive approach to display to the observer a true
3D view of a real world scene. Moreover, it is the only way of providing a 3D stereoscopic
effect on ordinary paper. There are not many techniques used to render anaglyph images,
and most of them are very empirical and are used exclusively for additive display devices.
The mathematical Linear Projection method was proved to be the best existing method for
rendering anaglyph images with high color stability and color fidelity. However, its limitation

is that it can exhibit strong ghosting in the rendered anaglyph images.

This study describes two separate anaglyph algorithms; one is targeted for CRT additive
display devices and the other one is aimed for printer subtractive display devices. Both of
these two algorithms are based on the Linear Projection method, in which they attempt to
reduce the ghosting effect introduced by the Linear Projection method while maintaining
the strength of the Linear Projection method. The study also characterizes the spectral
forward characterization functions of a CRT monitor and a printer which are used to test the
algorithms developed. The study first mathematically formulates the anaglyph phenomenon.
Next, it gives a new ghosting definition which is used to derive objective functions that are
used in the proposed algorithms. Besides those two algorithms, the study also introduces
a test that checks the compatibility between a colored-filter glass pair and a color display
device in term of the ghosting effect. The resulting rendered anaglyph images show that the
ghosting effect is significantly reduced.
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CHAPTER
ONE

Introduction

1.1 Problem area

This thesis relates to the topic of anaglyph stereoscopic display, and specifically to the devel-
opment of anaglyph algorithms used to render anaglyph images best displayed on popular

color media, namely CRT displays and ink-jet printers.

The human visual system (HVS) is extremely complex. It enables us to obtain important in-
formation about our surrounding environment such as the positions of objects, characteristic
of objects (e.g. color, shape), as well as their relationships. The HVS’s mechanism is based
on the so-called binocular vision mechanism, in which, when looking at a real scene, the left
eye sees the scene as an image (referred to as left-perspective view) that is slightly different
from the image (referred to as right-perspective view) received by the right eye of the same
scene. Based on these two images, the human brain calculates the depth information of the
scene. In contrast with binocular vision, monocular vision has two eyes that see the same
image and hence all the observed objects are in a 2D plane (e.g. the screen plane of TV).
Therefore, with monocular vision, we cannot have true depth perception. However, depth
perception can still be perceived through some other psychological mechanisms as summa-
rized by Lipton [3, pg.3|]. Note that the word “3D” throughout the entire thesis refers to

binocular stereoscopic views.

If the left and right perspective views are captured using cameras, then a stereoscopic dis-
play system can be used on these two images to give viewers a strong sense of true depth
perception, similar to observing the real scene. All of the stereoscopic display systems, in

fact, exploit the fundamental principle of binocular vision, in which they need to indepen-
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dently present the left and right perspective images to the corresponding eyes. In a number
of experiments, it has been shown that 3D images would send information more sufficient
to the observer than 2D images, since human beings react more strongly to 3D images [4].
Therefore, it is reasonable to believe that human beings want imaging systems that produces

pictures that are as natural and real as the things we see and experience all the time.

The anaglyph stereoscopic display system is one of the techniques for delivering the left
and right perspective images to the corresponding eyes. It exploits the color-multiplexing
technique in which one perspective image, say the left image, will be encoded in one set of
colors and the other perspective image is encoded in another set of colors. Then those two
color encoded views are superimposed into one unique image which contains both views. A
color display device, such as a CRT display (e.g. TV) or a color printer, then reproduces
this color encoded image. The light waves from this anaglyph image propagate to the left
eye through a colored-filter glass and to the right eye through another colored-filter glass.
The purpose of these two glasses is only to allow the appropriate color encoded image to
reach the appropriate eye. Other more complicated stereoscopic systems, such as the shutter
stereoscope, give better 3D quality if compared to anaglyph, due to the minimal degradation
in the image color. However, an interesting result from the experiment of Volbracht et al.
[5] showed that the information conveyed by the anaglyph mode is as good as that by the
shutter mode. Therefore, anaglyph is still a good way of reproducing the depth perception.

The biggest advantage of the anaglyph method is that it doesn’t require any special hardware
besides a very cheap pair of colored-filter glasses. An anaglyph image can be broadcast on
TV or shown in theaters without any modification. Unlike polaroid stereoscope or lenticular
sheet, the anaglyph method can be used to print an image that gives a good 3D impression on
ordinary paper without using any special ink or special printer. This obviously provides a new
efficient way of conveying information to the reader through the paper medium, especially for
science text books. The most recent Hollywood movie that applied the anaglyph technique is
“3D Spy Kids”. It used red and cyan colored-filter glasses for image separation and gave a very
pleasant 3D appearance. The limitations of the anaglyph method are the color distortion
effect (in which the 3D perception does not have the same color as the original real 3D scene),
the color rivalry effect (in which the left eye sees one color and right eye sees a different
color, and those two colors cannot be fused as a stable perceived color by the HVS), and the
ghosting effect (in which a small amount of information of the left-perspective image leaks

into the right eye and vice-versa).
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1.2 Objectives of the thesis

There is a very limited number of stereo anaglyph algorithms that have been developed.
Moreover, all of them were designed to be optimized for CRT displays. None of these existing
algorithms was designed for printers. Many existing programs for rendering anaglyph images
are often based on the so-called “Photoshop method”, where one perspective image is encoded
in one channel, say the red channel of CRT displays, and the other perspective image is
encoded in the other two channels, the green and blue channels. The Photoshop method is
simple, fast and doesn’t require the information of the display medium nor the information
of colored-filter glasses. Unfortunately, its resulting rendered anaglyph images give strong
unstable perceived colors, and hence it is often very uncomfortable to view these anaglyph

images.

A recent anaglyph algorithm, the Linear Projection method, renders anaglyph images that
have high color fidelity and color stability. However, it has the drawback of a strong ghost-
ing effect. Therefore, the objectives of the thesis are to develop two algorithms to render
anaglyph images from stereo image pairs to give a good 3D appearance. One anaglyph al-
gorithm is optimized for CRT displays and the other anaglyph algorithm is optimized for
printers. Both of the developed algorithms are based on the Linear Projection method,
in which they reduce the ghosting effect caused by the Linear Projection method without

sacrificing too much the strengths of the Linear Projection method.

1.3 Thesis outline

The work of this study is a combination of three different aspects: color theory, characteri-
zation of color devices, and the human stereo vision mechanism. Therefore, Chapter 2 serves
as background to give an overview first on theories and aspects of colors such as color dis-
tances, colorimetric color model, and color appearance model; second, an overview on color
reproduction devices (monitor and printer) and methods used to obtain their calibration
and characterization functions. Both the empirical method and model-based method are

discussed in this chapter.

Chapter 3 gives the mathematical framework of the anaglyph technique, what it is, how
it can be formulated, and a literature review of the few existing algorithms done for this
purpose. Chapter 4 uses the methods for color device modeling described in Chapter 2 to
model the specific color devices used in this study: EIZO CRT monitor and EPSON printer.
Chapter 5 presents a new anaglyph method for CRT displays. And Chapter 6 presents a
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new anaglyph method for printers. Finally, Chapter 7 summarizes the findings of this study

and avenues on how the work can be extended in the future.



CHAPTER
TWO

Background on Color

THE PURPOSE OF THIS CHAPTER is to serve as background for all the remaining chapters.
Section 2.1 gives the overview of color theory starting from the spectral level. Since the
new anaglyph algorithms are based on the mechanism of color output devices, Section 2.2

discusses the output color device characterizations.

2.1 Color overview

2.1.1 Color and visual perceptual attributes

This section serves as fundamental knowledge to understand the following sections. Color,
a psychophysical term, is used to describe what a human observer senses when visible light
arrives to the eyes. Visible light actually is electromagnetic radiation with wavelengths
between approximately 350 nm and 780 nm. The incidence of visible light stimulates two
type of receptors, which are rods and cones, in the retina of the human eye to produce
neural signals that are processed by the brain. The response of the receptors for light with
wavelengths below 400 nm and above 700 nm is very small and often can be neglected in the
calculations [6]. The retinal stimuli thus can be characterized by the incident visible light
power density spectrum (PDS) P(\) > 0. Figure 2.1 shows an example of PDSs of the red,
green, and blue light emitted by a Samsung Syncmaster LCD monitor.

The retinal responses are then transmitted to the brain where they are further processed
to give us the sense referred to as color. This process is nonlinear and very complicated.
The sense of color can be classified into different visual perceptual attributes which are hue,

brightness, lightness, colorfulness, chroma, and saturation |1, pp.119-23|. Even though there
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Figure 2.1 PDSs emitted from 17" Samsung Syncmaster LCD monitor. The power unit of
the y-azxis 1s not important in many applications.

are many color models that have been developed to represent and predict colors, all the color
models can be divided into two groups: Colorimetric Color Models, that represent colors in
terms of the retinal responses, and Color Appearance Models, that represent colors in terms
of visual perceptual attributes. Strictly speaking, a color appearance model is usually built
upon a colorimetric color model (often the CIE XYZ color model). Note that, throughout
this thesis, the phrase “color model” usually has the same meaning as the phrase “color space”

and they are interchangeable.

2.1.2 Color distance

In most of the applications related to color, one question is often raised as to how the
closeness (perceived difference with respect to color attributes) of two colors under given
viewing conditions can be modeled. In this research, the heart of the new algorithms is the
optimization process in which its objective functions are based on the closeness of perceived

colors and desired colors. Therefore, it is important to discuss the closeness of two colors.

The closeness is often known as color difference or color distance. In general, for a given
color model, the color distance metric, used to quantify the color distance, is often designed
to make its results as close to human judgments as possible. The error metric between two
very different colors is not very meaningful and hence most of the existing color distance
metrics are focused on small differences between two colors [1, pg.28]. The definition of a
color distance metric enables us to define the uniformness of a color model in which equal

distance metric values in a color model correspond to equal perceived differences.
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2.1.3 Colorimetric model

There are two different approaches for introducing the representation of a color: the first
approach is to directly introduce the tristimulus values which are the representation of a
color; the second approach is to start at the PDS level and to mathematically derive the
color representation. In this section we will discuss the second approach as in this study
we mainly work with PDSs emitted from a CRT display or reflected from a paper. All the

proofs and arguments in the present section can be found in Dubois’ course notes [6].

First, all PDSs of visible light can be formed as a set

Amaz
P=<FA), Anin A< A |[f(A) >0, /\f()\)\d)\<oo . (2.1)
Amin
There is an interesting psychological phenomenon in which two PDSs C}(\) and Cy(\) will
give an identical color sensation (same retinal stimuli) under the same viewing condition due
to the fact that the HVS only has three types of cones. A color, denoted as [C], can be

)\maz
defined as a set of all PDSs C'()\) in the set P such that three numbers | [ C(X)L(A)dA,

Amin
[ CNMN)dA, [ C(A)S(A)dA | are equal, where L(X), M(\), and S()) are the long-
)\min )\min

wavelength, medium-wavelength, and short-wavelength cone sensitivities, respectively. Ob-
viously, the set [C] is a subset of P. A set of all possible colors is defined as physical color
space and denoted as Cp. The physical color space Cp, however, is not a vector space, as an
element of Cp does not have a negative. By extending the set P, the new set £, which will

include the PDSs with negative power, can be defined as

)\mafll
L=dFO), A <A< A /\f()\)\d)\<oo . (2.2)

In £, by extending the color definition, a color [C] can be defined as a set of all PDSs C'(\)

Amaﬂ') Amaﬂ') >\ma-7‘
in the set £ such that [ [ C(A)L(\)dX, [ CA)MN)dX, [ C(AN)S(A)dX | are equal.

Any two PDSs Cj(A) and Cy(\), which are in the set £ and belong to a color, are called
equivalent, denoted as C1(\) EC2(A). The color notation [C'(A)] can also be used to indicate
the color in which its set of PDSs includes the particular PDS C(\). It has been proven that

the set of all colors will form a color vector space, denoted as C, in which the vector addition



8 CHAPTER 2 BACKGROUND ON COLOR

and multiplication by a scalar operators are defined as

alC(N)] = [aC (V)]

(2.3)
[CLN] + [Co (V)] = [CL(A) + C2(A)]-

As one can see, the physical color space Cp is a subset of C, and if a color in C contains at

least one element of P then it belongs to Cp and it can be physically generated and seen.

The dimension of the color vector space C is 3. Therefore, by applying vector space theory,
a color can be represented exactly in terms of coefficients with respect to a basis, instead of
by a PDS,

[C] = C1[P1] 4 Co[P) + C5[ Py, (2.4)

where (Cy, Cy, C3) are three real numbers called the tristimulus values. ([Py], [P, [Ps]) are
three linearly independent colors and considered as three primaries. Often, the primaries
are carefully chosen such that the sum of one unit of each primary matches a selected
reference white. For example, Red [R())], Green [G(\)], and Blue [B(A)] colors emitted by
the Samsung LCD monitor in Figure 2.1 will form a basis for C, and the sum of one unit of
each primary will produce a D65 reference white which is the daylight. There is no strict
requirement that the primaries must be physical colors, as in the case of CIE XYZ primaries,

which are considered as the standard primaries from which other sets of color primaries are
described.

2.1.3.1 Color matching functions

The tristimulus values in Equation 2.4 can be computed by

)\maa:

)\min

where C'(A) is the PDS of the incident light, and the functions p;(\) are referred to as the
color matching functions (CMF) associated with the primaries [P;]. Note that the set of
three CMFs p,;(A) can be different from the three cone sensitivities L(\), M(A), and S(\).
Figure 2.2 shows examples of CMFs defined by The Commission Internationale de ’Eclairage
(CIE) for CIE XYZ primaries. In digital computation, the PDS C'()\) and the CMFs p,;()\)
have values only at discrete uniformly spaced wavelengths {/\j}j-v:’ol over the region [Ayin,

Amaz), denoted as C[\;] and p,;[A;] respectively, thus Equation 2.5 can be approximated by a
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Figure 2.2 CIE 1931 XYZ Standard Colorimetric Observer’s color matching functions.

Riemann Sum

Ci=Y CI] BN AN (2.6)

2.1.3.2 Transformation of primaries

A given color will have different tristimulus values for different sets of primaries. Therefore,
it is necessary to establish a relationship between two different sets of tristimulus values of
the same color. In the thesis, this relationship will be used to establish the characterization
function of a CRT display (Section 2.2.5.2). This characterization function will then be used
in the anaglyph algorithm developed for a given CRT display.

Let ([PL(A)], [P2(N)], [Ps(A)]) be three primaries of the color vector space C with three CMFs
(D1(N), Do(A), D3(A)) and ([Q1(N)], [Q2(N)], [@3(N)]) be another three primaries with three
CMFs (g, ()N), @y(N), G3(N)). For an arbitrary color [C'()A)], if we assume that the vectors Cp =
[Cp1 Cpa Cps]” and Cg = [Cq1 Ca Cos|” are the tristimulus values of that color in primaries
(|P1], [P, [P5]) and primaries ([Q1], [Q2], [@3]) respectively, then the relationships between
Cp and Cg and between the two sets of CMFs can be written as the following statements

in terms of matrices

Co=A-Cp, Cp=A"1.Co, (2.7)
[T BN BN T =A[nN » 5], (2.8)

where [p;[A] Do\ Ds|A]] and G, [N Go[A] T5[A]] are N x 3 matrices (these two matrices hold
the discrete values of (p;()), Po(A), P3(N)) and (g; (M), Gu(N), G5(A)). The matrix A has the
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Figure 2.3 Relative luminous efficiency V (\).

form

ailr @2 413 N-1
Aji= | ag1 ag ag | where aj, = Z PiNilg,[M]AA, J, k=123 (2.9)
i=0

a3; dz2 G33

For example, the transformation matrix A between the CIE XYZ primaries and the EIZO

CRT monitor primaries is

Cx 0.3303 0.3255 0.2708 CEerzo,r
Cy 0.0422 0.1603 1.4109 CErrzo,B

2.1.3.3 Luminance and chromaticity of colorimetry model

The luminance of a color [C'()\)], denoted as Cf,, can be determined in terms of the primaries
[P1], [P2], and [P5] as

)\maa:
C1 = K, / COVV(N)AA, (2.11)
)\min
or OL = ClplL + CQPQL + O3P3L, (2.12)

where K, is a constant that determines the units of luminance; V() is the relative luminous
)\maz

efficiency curve as shown in Figure 2.3; and Py, = K,,, [ Pi(A\)V(A)dA is the luminosity
Amin

coefficient of the primary [P;], ¢ = 1, 2, 3.

Similarly to the luminance, the chroma of a color [C'(\)] with tristimulus values of (Cy, Cy,
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C3) with respect to primaries [P], [P, and [Ps] can be represented by the chromaticity
coordinates (c;, ¢z, ¢3) and can be calculated as

— Ci S
Ci = Ci¥Cot 0y 1=1,2.3,

(2.13)
where ¢y + ¢y +c¢c3 = 1.

Only two out of three chromaticity coordinates need to be specified. Often the chromaticity
coordinates of a color are plotted on a two dimensional chromaticity diagram with axes ¢,
and cy. The chromaticity diagram is a useful visual aid for illustrating the gamut of a device
as will be mentioned in a later section. Given any two of the chromaticity coordinates and
the luminance of a color (¢, ¢y, Cr) then its tristimulus values (Cy, Cy, C3) can be found as

follows

;- C
C; = G L . i=1,2,3. (2.14)
cr-Pip+co- Pop+c3- Pap

A color thus can be represented in terms of the tristimulus values (Cy, Cy, C5) or in terms
of the chromaticity coordinates and luminance value (c;, ¢, Cr). Chromaticity coordinates

will be used in Section 5.1.2.

2.1.3.4 CIE 1931 XYZ color space

The most commonly used color colorimetry model is the CIE 1931 XYZ color space with
respect to which all modern color models are defined. In this research, the CIE XYZ space
will be used as the color representation in the both anaglyph algorithm for CRT media and
the anaglyph algorithm for printer media. The three CIE XYZ primaries are not physical
colors (not realizable) because the purpose of the CIE XYZ space was for fast calculations.
Figure 2.2 shows three CMFs T(\), 7(\), and Z(\) of CIE XYZ color space corresponding to
the primaries [X], [Y], and [Z] respectively. A color [C'(A)] in the CIE XYZ space thus can

be represented by its tristimulus values (Cy, Cy, C) as

Ox = k- AT””C(A) “Z(\) - dA,
Cy = k- AT””C(A) G\ - d, (2.15)

)\min
Amaz

Cy=k- [ CO)-Z(A)-dA,

)\min
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where k is a scalar. Thus, the xyz chromaticity coordinates cy, cy, and ¢z of the color [C'())]

can be calculated as

. Cx . Cy o Cy
T COx+Cy+Cy Y T Ox+ Oy + 0y YT Cx+Cy +Cy

cx (2.16)

The luminance of the colors [X] and [Z] are zero while the luminance of the color [Y] is 1.

Given cy, cy and (', the tristimulus values can be found as

Cx = (2)-cn
Cy = Cn, (2.17)
Cz = (#)-cn

Therefore, the Y tristimulus value is the luminance of the color [C'(A\)]. The color distance
metric in the CIE XYZ space is the Euclidean distance between the two sets of tristimulus

values and is defined as

AFExyz = /(ACx)? + (ACy)? + (ACy)?, (2.18)

where AOX — Clx—ng, AOY — Cly—ng, and AOZ — 012—022. An experiment performed
by MacAdam [6] showed that the CIE XYZ color space is a very non-uniform color space in

the sense of Section 2.1.2.

2.1.4 Color appearance model

This section introduces the CIELAB color space that is used in the optimization problem
for an anaglyph algorithm for printer media. This section is based primarily on Chapters 1
and 2 in the book of Sharma [1|. One trivial requirement for a color model is that colors
with the same representation values must look the same. However, this requirement often
fails for the color colorimetry model, since two colors with the same tristimulus values may
look different depending on their contexts. This restriction is because the color colorimetry
models are designed based on one strong condition: all colors must be viewed under the
same designed wviewing conditions - which are the stimulus, proximal field, background,
surround, and modes of viewing; for more details about these viewing conditions please refer
to reference [1, pg.137]. One example for this is two colors, in which one is displayed on
a CRT display and one is displayed on paper and yet have the same CIE XYZ tristimulus
values, will often look different. The phenomenon that the appearance of a color depends on

a particular viewing condition is called a color appearance phenomenon. Many color models
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try to formulate one or some of the color appearance phenomena in order quantify the visual
perceptual attributes and use those values to represent color; such models are known as color

appearance models. An excellent source about color appearance models can be found at |7].

2.1.4.1 Color appearance phenomena and chromatic adaptation models

There are many color appearance phenomena as Johnson and Fairchild |1, pg.141] have
summarized. The Chromatic adaptation phenomenon, in which the appearance of a color is
quite stable under the changes in light source’s chromaticity, is perhaps the most important
appearance phenomenon. There are many attempts to model the chromatic adaptation such
as the pioneering von Kries model and its derived models such as the Fairchild model, the
Bradford model, etc. The chromatic adaptation model is often used to predict the CIE XYZ

tristimulus values of a color in different viewing conditions.

e The von Kries chromatic adaptation model |1, p.154-55] transforms the CIE XYZ
tristimulus values of a color in one viewing condition to CIE XYZ tristimulus values

of this color in another viewing condition

X % 0 0 X,
Y, | =M. 0 ﬁ# 0 M- | v |,
Zy 0 0 g Z
Lphite Xowhite,1 Lphite,2 Xwhite,2
Myniten | =M | Yunien |5 | Monitez | =M | Yunie2 | (2.19)
Swhite,1 Zwhite,1 Swhite,2 Zwhite,2
0.4002 0.7076 —0.0808
M= | —0.2263 1.1653 0.0457 | ,

0.0 0.0 0.9182

where (Lynite1, Muwhiten, Swhite1) are the cone responses of the white point, whose
CIE XYZ tristimulus values are (Xynite1, Ywhite1, Zuwhite1), i the original viewing
condition, and (Lypite2, Muwnite2, and Sypite2) are the cone responses of the white
point, whose CIE XYZ tristimulus values are (Xuynite2, Yuhite 2, Zuwhite2), in the new

viewing condition.

e The Bradford chromatic adaptation model, which added a nonlinear term based on
“spectrally sharpened” cone fundamentals upon the von Kries model, can be linearized

and simplified down to Equation 2.19 [8] and with the linear transformation matrix M
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as
0.8951  0.2664 —0.16614

M= | —0.7502  1.7135 0.0367 | . (2.20)
0.0389 —0.0685 1.0296

For full details about the Bradford chromatic adaptation model please refer to reference

8],

2.1.4.2 CIELAB color space model

The CIELAB color space model was designed based on the CIE XYZ color space to improve
the perceptual uniformness of the color space. The CIELAB color space will be also used
in the optimization problem in both the developed anaglyph algorithms for CRT media and
printer media. It is also used to test the accuracy of the characterization functions of the
EIZO CRT monitor and the EPSON printer in Chapter 4.

If a color [C] has CIE XYZ tristimulus values of (Cx, Cy, Cy) with (Wx, Wy, W) as the
CIE XYZ tristimulus values of the reference (or the adapting) white, which are typically the
CIE XYZ tristimulus values of the brightest color in the view, then this color is defined in
the CIELAB space by three coordinates of (Cr., Cous, Cp) where |1, pg.161]

Cp. = 116f (%) — 16,

o 3 (52) -1 ()
Che = 200 <f (g—g) _ (%)) , (2.21)
et if z > 0.008856,
fle) = { 7787(x) + 45 if = < 0.008856.

The C'p, value predicts the lightness attribute, while C,, and Cj, values predict the chroma
and hue attributes of the color. CIELAB exploits the CIE XYZ scaling chromatic adaptation
model, in which the CIE XYZ tristimulus values are scaled down according to the reference

white.

There are a few different color distance metrics developed for the CIELAB color space. The
simplest metric is the Euclidean distance between the CIELAB coordinates of two colors
[C4] and [Cy]. A better distance metric is CIE-94 used in this study [1, pp.36-37]
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am=f(85) + (22)+ (3%)°
Tab = \/(Cla*)2 + (Cu)?,
AL* = Cype — Copr,
ACT = 1ab — Caaps
AR = \[(AEL) = (AL +(ACY)?),
C2y = VCrare Coarr
Se = 140.045C%,
Sy =1+0.015C%,
Sr,=1.

(2.22)

Here, all the three scaling parameters are set to 1.

2.2 Color output devices

Most of the devices involved in a color imaging system can be classified as input devices
(e.g. digital camera, scanner), which capture the color images and encode the colors, and
output devices (e.g. monitor, TV, printer) which reproduce the color images on different
media. As mentioned in Chapter 1, an anaglyph stereoscopic display system includes a color
output device. Depending on a particular color display device there will be an optimized
anaglyph algorithm for it. The developed anaglyph algorithms require knowledge of the
relationship between the digital input signals and the PDSs produced by these color display
devices. Therefore, this section discusses the steps to establish those relationships for typical
color output devices which are CRT display and printer. This section is based primarily on
Chapters 5, 10, and 11 in the book of Sharma [1].

2.2.1 Generic output device modeling

This section discusses the common approaches for establishing the function between the
digital input signals and the PDSs produced by a color output device. Depending on the
type of color output device, one approach may be more appropriate than another one. The
upper path in Figure 2.4 is a typical setup of an output device. The digital input signal d
first is sent through a Calibration process, denoted as Yca(+), to become the signal d’. In
the case of CRT displays, for instance, the signal d is a vector of three integer values R, G,
BJ, each in the range of [0, 255]. The calibration process adjusts the color device to make

sure that this device is in its predefined initial state [1, pg.272]. The physical output color
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Figure 2.4 Output device forward characterization block diagram. (Reproduced from [1,
pg.284])

device produces an output color signal cp based on the signal d’. In many applications, the
output signal cg is the CIE XYZ tristimulus values or CIELAB coordinates. However, in an
anaglyph stereoscopic display system, we need co to be a PDS C(\). This PDS C(\) is not
observed directly by the eyes, but rather is attenuated when propagating through colored-
filter glasses (Section 2.3). It is these attenuated PDSs that the eyes perceive. Therefore,
in order to predict the perceived color through colored-filter glasses, we need to know the
reproduced PDSs C'(\). We can see that the signal d can be thought as a representation of
the output color cp. However, this signal d can only be interpreted correctly by its associated
color output device and hence the signal d is also referred to as color device-dependent, while

the output color cp is referred to as color device-independent.

The lower path in Figure 2.4 shows a mathematical model which is used to characterize the
whole upper path process. If the same input signal d is fed into this model then its output
signal ¢ can be seen as an estimation of the real output signal cp. This mapping function
is referred to as the forward characterization function (FCF). If ¢ and co are PDSs then
FCF is called the spectral FCF (SFCF), denoted as Yspcr(:). The need for the calibration
process is based on the fact that establishing a SFCF is often an expensive process in terms
of time and labor, and it is needed every time the device’s response changes. Instead, a fast
and easy calibration process can be used frequently to keep the SFCF accurate. To display
an arbitrary device-independent color, we use the inverse FCF to estimate the input signal
d.

The function Tgper(+) can be found by two different approaches [1, pg.274|: empirical-based
and model-based. In empirical approaches, a large enough set of inputs d are fed into the
upper process, and the output samples are measured by using a colorimeter, spectropho-
tometer, or spectroradiometer instrument. Then multi-dimensional interpolation and data
fitting techniques can be applied to find the relationship between the input and output color
samples. In model-based approaches, a mathematical model will be used to describe the

device behaviors, and the model’s parameters can be found by the relationship between a
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small number of inputs d and the corresponding output color samples co.

2.2.2 Multidimensional data fitting and interpolation

As mentioned in the previous section, in the empirical approach, we need to use the regression
technique to perform data fitting and interpolation. The polynomial regression technique is
used to model Tgpop(-) for the EPSON printer in Section 4.3 and hence will be discussed in
detail.

Assume that an experiment has T training samples in which d;= [d;1, di 2, ..., dis] is the
1xm row vector of m inputs and ¢,= [ct1, ¢r2, ..., Ctn] is the 1Xn row vector of n outputs,
and t = 1, 2, ..., T. For instance, the sample vector d; can be the EPSON printer input [R,
G, B] values (in this case m = 3) and the output vector c; is the 151 discrete values of the
PDS reflected light corresponding to that input (in this case n = 151). This section is based
on Section 5.4 and Chapter 11 in the book of Sharma [1]. Although trilinear regular lattice,
sequential interpolation, and neural network methods will be involved in Section 4.3.1 along
with the polynomial regression method for comparison, they will not be discussed here. For
details about trilinear regular lattice, sequential interpolation and neural network methods

please refer to Chapter 4 in Kang’s book [9].

The polynomial regression technique is a special form of least-squares regression wherein
the characterization function is approximated by a polynomial. The N-order polynomial
approximation for a transformation of a training sample vector with three inputs is given by
[1, pg.295]

N N N
= 33 (Wikai-diy-dly-diy)  t=1,2,. Tandl=12.n (2.23)

i=0 j=0 k=0

In matrix notation, Equation 2.23 can be written as

Wo,0,0,t,1 Wo,0,0t,2 -~ W0,0,0,t,n
Wo,0,1,¢,1 Wo,0,1,t,2 - W0,0,1,t,n
— N N N sUsLyly sUsLyly Uy Lyl
Ct — |: 1, dt’g, dt’Q, ey dt,l * dt,2 * dt,?) :| bl
WN,N,Nt,1 WN,NNt2 -+ WN,NNtn
= Pt A

(2.24)



18 CHAPTER 2 BACKGROUND ON COLOR

The optimal matrix A must satisfy the condition

T
) 1
Aopy = arg min {T ; lct — pe - AHQ} . (2.25)

If P is the Tx (N + 1)3 matrix [pi; po; ... ; pr|, then the solution for Equation 2.25 is

-1

A=(P"-P) -P".C (2.26)

2.2.3 Spectral white-point normalization

To model the Yspcp(+) processes for both a CRT display and a printer, the PDSs of emit-
ting lights (in the case of the CRT display) or reflecting lights (in the case of the printer)
are needed. These PDSs can often be measured by using measurement devices such as
spectrophotometers or spectroradiometers. Often, the absolute units of these PDSs are not
known nor often required in many applications. Therefore, these PDSs need to be nor-
malized. The scaling value k£ in Equation 2.15 is the normalization constant and often is
chosen to have the Y luminance value in the CIE XYZ tristimulus values of the white color

reproduced by the color device to be 1 [1, pg.289], and thus

1
k= : (2.27)

W) o) - ax

>\min

where W () is the reproduced PDS of the white color which can be the brightest point that
the color device can generate. Therefore, a measured PDS Chjeasured(A) from a device now

can be normalized according to the white point as

CNorma.lized(A) =k- C1Meausured()\)‘ (228)

This section will be applied to the raw measured PDSs that are emitted from the EIZO CRT
monitor and the PDSs reflected from the EPSON printer in Chapter 4.

2.2.4 Device gamut, gamut mapping, and device profile

This section and the next are needed to understand the printing process of the EPSON
printer in Section 4.3.1.1. In practice, a color device can only capture or reproduce a certain
range of physical colors, and this set is referred to as the color gamut. This gamut is a

subset of the set of all physical colors Cp. In a color colorimetric model, a color gamut can
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be projected onto a chromaticity diagram (e.g. the xy chromaticity diagram) as a tool for
gamut visualization. For example, Figure 2.6 shows the xy chromaticity gamut of the EIZ0O
CRT monitor. We can see that all the physical colors lie inside the area made up by the
sharkfin-shaped curve and the line of purples, and all the colors in the EIZO CRT monitor’s

gamut have xy chromaticities that lie within the indicated triangle.

If we want to display colors that are outside the gamut, then first, these out-of-gamut colors
must be mapped into colors that are inside the device’s gamut. This mapping is referred to as
gamut mapping. A gamut mapping is designed based on the color rendering intent, which is
the specification of what properties of color (e.g. color attributes) we want to maintain in the
reproduction color |1, pg.642]. The International Color Consortium (ICC) has classified the
rendering intents into four different categories: perceptual intent, saturation intent, relative
colorimetric intent, and absolute colorimetric intent. The perceptual intent was chosen for
the EPSON printer printing process in this thesis. In the perceptual intent that is useful
for photographic-type images, the perceptual appearance of an image color is preserved, and

only a few or even no colors will stay the same as in the original [1, pg.643].

Every commercial color output device is associated with a profile. This contains the de-
scription of the device, the inverse FCF, and the device-independent color space. ICC-CMS
(Color management system), which is a program module (e.g. Microsoft ICM or Adobe
ACE), will be based on this profile and the desired color rendering intent to make sure the

color device reproduces correct color. For more detail about profiles, one can refer to [10].

2.2.5 CRT displays

The general background about color devices has been overviewed in previous sections. In this
section, we look at a particular color output device: CRT displays. The results of this section
will be used in an anaglyph algorithm that renders anaglyph images to be best displayed
on a given CRT display. This section also serves as background for characterizing the EIZ0O
CRT monitor in Section 4.2.

Perhaps the most important color output device is the cathode-ray tube (CRT). The working
mechanism of the CRT is that three voltages control red, green, and blue electron guns to fire
electron beams onto a small area on the screen covered with red, green, and blue phosphor
dots. This small area is referred to as a pixel. The collision of the electron beam from
red, green, and blue electron guns with the red, green, blue phosphor dots, respectively, will
excite the phosphors to emit red [R())], green [G())], and blue [B(\)] lights. Due to the

small size of the pixel, we will see those three separate lights as a single color, which is the
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additive mixture of those red, green, and blue lights. By controlling the input voltages of
the guns, the CRT can produce different colors. The red, green, blue input voltages in turn
are controlled by their corresponding three digital numbers (R', G’, B’) (this is the input
signal d’ in Figure 2.4), each number is an integer in the range of [0, 255| for 24-bit color.

In the CRT, if the gun independence and pixel independence assumptions |1, pg.281] can be
made, then the spectral light emitted at a pixel x, C(\, x), can be formulated as [11]

CA\x) = R\x)+G\x)+ B(\x)
= Tcun (R (X)) - Rinaz (A X) + Taun (G (X)) - Grnaa (A, X) (2.29)

+ T Gun (B' (X)) * Biaz (A, %),
where R(\,x), G(A,x), and B(\,x) are the white-point normalized PDSs (Section 2.2.3) of
the lights emitted by the red, green, and blue phosphors. R,,..(\,x) is the red emitting
PDS at its maximum intensity, and Yy, (-) is the nonlinear function that describes the

relationship between the digital inputs and the driving gun voltages.

2.2.5.1 CRT Calibration

In this section, we establish the function Yy (-) for a CRT display, denoted as YTca crr(-). It
has the input signal of d = (R, G, B) (R, GG, and B are in the range of [0, 1]) and the output
signal of d' = (R, G’, B’). Furthermore, the function Yca crr(-) is a separable function
which means that each of components R', G', and B’ can be computed directly from R, G,
and B, respectively. We first set the brightness, contrast, and simulated temperature of the

CRT display to the known conditions and then establish the relationship

R'(x) = Yca,crr(R (x)) = Tau, (R(X)). (2.30)

Similar expressions hold for G’ and B’. R is also referred to as the red non-gamma-corrected

value, whereas the R’ value is also referred to as the red gamma-corrected value.

2.2.5.1.1 Simple gamma-correction model The simplest form of the function YTy ()

is |1, pg.325]
/ TR
R < R ) , (2.31)
2n —1

where n is the number of bits of digital input R’. This is known as the simple gamma-

correction model. To find the value of g, first for each different value of R’ in a set of

pre-selected digital signals R’ (and the other two signal values G’ and B’ are set to zero),
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we measure the PDS of the emitted light from the CRT display and denotes these measured
PDSs as Cyieasured (A)- If Vg is known then from Equation 2.39 !, the PDSs of emitted lights
from the CRT display can be estimated, denoting these estimated PDSs as Crgtimated())-
We can use a nonlinear optimization method to find vz so as to minimize the color dis-
tances between the measured colors [Cyeasured(A)] and the corresponding estimated colors

[Crstimated (A)]. Similar expressions and steps hold for v and vp.

2.2.5.1.2 GOG gamma-correction model This model is an extension of the simple

gamma-correction model where the function Ygyuy,(+) is defined as [12, 13]

(2.32)

/ vy . /
R = (kor (5i) +1—kor) " ifkgr 5ig +1—kgr >0,
0 otherwise,

where kg r is a constant gain, greater than 1. The steps for obtaining the gamma value g

are the same as the steps used for the simple gamma-correction model.

2.2.5.1.3 ITU-R 709 gamma-correction recommendation If a CRT display is set
to a manufacturer predefined state then all three display gamma values should be around

2.2, and the standard gamma-correction function suggested by ITU-R 709 is [6]

, | 45R if R <0.018,
B { 1.099R%% — 0.099 if 0.018 < R < 1.0, (2.33)
p_ | 022 if R <0.081,
{ (2009) %% £ 0,081 < R < 1.0.

Again similar expressions hold for G and B.

2.2.5.2 Model-based CRT SFCF

In this section we will establish Yspcr(-) for a CRT display, denoted as Yspcr crr(-). This
function has the input as a set of three signals 0<R, GG, B<1 and the output of PDS C'(\)
with Apin KA Az If three colors [Riaz (A, X)], [Gmaz (A, X)], and [Byax (A, x)] are chosen
to be three primaries then from Section 2.1.3.2 and Equation 2.29 the CIE XYZ tristimulus
values (Cx, Cy, Cy) of a reproduced color [C'(\,x)] with respect to these primaries can be

calculated as

Discussed in Section 2.2.5.2



29 CHAPTER 2 BACKGROUND ON COLOR

CX Rmax,X Gmax,X Bmax,X R R
OY = Rmaac,Y Gma:v,Y Bma:v,Y : G =A- G ) (234)
C1Z Rmax,Z Gmax,Z Bmax,Z B B

where (Rpaz,x, Rimazy, Rmaz,z) are the CIE XYZ tristimulus values of the color [R,,q. (A, x)].
By measuring the PDS of each primary at its maximum intensity the matrix A can be

obtained. The matrix A can also be rewritten as

Rmaac,X Gma:v,X Bma:v,X

A = Rmax,Y Gmax,Y Bmax,Y
L Rma:v,Z Gmaac,Z Bmaac,Z |
Tmaz, X 9mazx, X bmaz,X B R O O (235)
Tmazx,Y 9mazx,Y bmaz,Y max,Y

= 1 1 1 |- 0 Gumawy 0 ,

T"max,Z Imazx,Z bmaac,Z B
L Tmaz,Y Imazx,Y bmaac,Y - 0 O maz,Y

where (Tymaz X Tmaz,ys Tmaz,z) are the xyz chromaticity coordinates of [R,q. (A, x)| in the
CIE XYZ color space. Normally, we want the CIE XYZ tristimulus values of the white light
(Wx, Wy, W), which are reproduced by summing one unit of each primary, to match the
CIE XYZ tristimulus values of reference white. The reference white should be the measured
brightest point (normally when all the inputs are set to 1). If the measured PDS of the
brightest point is not available then we can replace it by a known reference white point such
as D65 which has the CIE XYZ tristimulus values (0.9504, 1.0000, 1.0889). Therefore, from
Equations 2.34 and 2.35, we want

Tmaz, X 9maz, X bmam,X
WX Tmaz,Y Imazx,Y bmaa:,Y Rmaxvy O O 1
Wy = 1 1 1 : 0 Gma%y 0 . 1 . (236)
bm
WZ T"max,Z Imax,Z ax,Z O 0 Bmax,y 1

Tmaz,Y Imazx,Y bmaac,Y

The values Rpozy, Gmaz,y, and B,y that satisfy the equation above can be calculated as

-1

Tmaz, X 9maz, X bmam,X

Rmaac,Y,Norm Tmaz,Y Gmaz,y bmaz,y WX

Gmax,Y,Norm = 1 1 1 : Wy . (2 . 37)
T b

Bma;E’Y,N()rm max,Z 9maz,Z max,Z WZ

Tmazx,Y 9mazx,Y bmaa:,Y
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Table 2.1 The zy chromaticity coordinates of three primaries and the CIE XYZ tristimulus
of the reference white used in sRGB color space. Note that these values are the same as
those used in the ITU-R 709 RGB color space.

Red | Green | Blue | White (D65)
0.640 | 0.300 0.150 0.3127
y | 0.330 | 0.600 | 0.060 0.3290
z | 0.030 | 0.100 | 0.790 0.3582

Therefore, the measured PDSs R,,4: (A, X), Grar (A, X), and Bz (A, X) need to be normalized

to give those normalized luminances

Rmax orm
R om0 %) = Ry (03 - (Frezom ), (239
maz,Y

Similar expressions hold for G,uz Norm (A, X) and Byuaz Norm (A, X). Therefore, the output PDS
C(A,x) can be found by

O(/\u X) = R (X) : Rmax,Norm()\y X) + G (X) : Gma:v,Norm(Au X) + B (X) : Bmax,Norm(/\a X)7
= Ysrer,crr(R (x),G (%), B (x)).

(2.39)
And finally the matrix A in Equation 2.35 can be normalized to become
mer B ey | [ Reevvom 0 0
A= 1 1 1 . 0 Gmaz,y,Norm 0 : (2.40)
Tmess gmse2 bnasz 0 0 Buawyom

Tmazx,Y 9mazx,Y bmaa:,Y

2.2.5.3 sRGB color space

It is worth-while to mention briefly the sRGB color space as we will use it in the printing
process in Section 4.3.1.1. Many CRT monitors have some similarities in three primaries’ xy
chromaticity coordinates. Therefore, the main purpose of the sSRGB color space is to reduce
the color reproduction process complexity without sacrificing much the color accuracy [14].
The digital input d = (R, G, B) in the SRGB color space can be displayed directly on CRT
monitors and they are most likely to look similar. The chromaticities of the sSRGB primaries
and the reference white are shown in Table 2.1. The details of the SRGB gamma correction

process are shown in reference [14].
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2.2.6 Halftone printers

This section is needed for establishing the SFCF of the EPSON printer Yspor printer(+) (Sec-
tion 4.3) which is used in developing the anaglyph algorithm that renders anaglyph images

printed on ordinary paper to have a pleasant appearance.

A printer, which is a subtractive color device, can reproduce a color by mixing three type
of colorants: cyan (C), magenta (M), and yellow (Y) and place this colorant mixture on a
medium such as paper or transparency. A light S(\) will be reflected from (in the case of
paper) or transmitted through (in the case of transparency) this colorant mixture when it is
illuminated by an illuminant 7(\). We have S(\) = I(\)-Ref (), where Ref () is the spectral
reflectance (or transmittance) function of this colorant mixture. With an appropriate mixing
of colorants to selectively modify the spectrum illuminant light we can produce a desired

color. The quantity of each colorant in the mixture is controlled by a digital number.

Halftone printers exploit the optical illusion in which the human eye cannot distinguish small
dots of colorants from a far distance and hence combine the light reflectance or transmittance
from those colorant dots to give a unique color. It divides the printable area into small areas
of so-called screen cells (similar to pixel in CRT). These screen cells are further divided
into a matrix of smaller areas called dots where the printer may or may not place a fixed
concentration ink droplet into these dots. By controlling the size, shape, frequency, and
angle of those dots, halftone printers can produce desired colors. The characteristic of a
printer is complex due to the nonlinear combination of many factors such as the unwanted
absorption bands of colorants, the light scattering in the paper leads to optical and spatial

interactions, imprecision of the colorant dots size. |1, pg.283|.

The initial state of printers can be achieved by two common approaches: channel-independent
and gray-balanced. Note that the number of colorants in a printer is not necessary restricted
to only three colorants C, M, Y. Additional colorants can be black (K), orange (O), or green
(G). In this case, the digital input d’ must be represented by a set of more than three values,
for example a set of six values (C, M, Y, K, O, G) for a six-colorants CMYKOG printer.
However, a color can be sufficiently represented by a set of three coefficients, e.g. (C, M, Y).
Therefore, this printer’s driver will also carry an extra step of mapping the three values (C,
M, Y) into six values (C, M, Y, K, O, G).

Often, many commercial halftone printers have drivers to work directly with programs that
process colors which are represented by the CRT device-dependent format (e.g. the sRGB

color space) and hence its input is a set of three signals (R, G, B). We refer these printers
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to here as RGB printers. Therefore, a RGB printer’s Yspcp printer (-) has the input as a set of
three signals 0<R, G, B<1 and the output of PDS C'()\) with A, <A< Apaz. The EPSON
printer used in this study is a RGB printer.

For a halftone color printer, in the model-based approach, the color separation process fol-
lowed by the model-based Neugebauer model or its derived models such as Yule-Nielsen or
Cellular Neugebauer are quite accurate to model the function Yspcr printer(-). The Neuge-
bauer model is based on the assumption that the unified spectral reflectance Ref()\) within
a screen cell is a sum of weighted spectral reflectance of all the colorant combinations. For

an overview on the Neugebauer model, one can refer to Section 5.10.2.3 in [1].

In empirical approaches, a sufficiently large set of colors is printed on a paper. The spectral
reflection of each printed colorant mixture is then measured. Finally, the printer SFCF can
be established via a data fitting or interpolation technique such as the polynomial regression,
the trilinear interpolation, or the neural network method (Section 2.2.2). However, due to
the nonlinear characteristic of the printer SFCF, linear regression is obviously not suitable
for printer characterization. The EPSON printer SFCF is derived based on this approach
with the polynomial regression so as to give the best results in terms of the accuracy and

the execution time if compared to other interpolation techniques.

2.3 Colored-filter glasses

In an anaglyph stereo system, the emitting or reflecting lights from the display devices have
to go through the colored-filter glasses. This section describes the effect of a colored-filter
glass. A colored-filter is a device that attenuates the PDS of lights C'(\) passing through it
at certain wavelengths according to its spectral absorption curve f(\) with 0<f(A\)<1 (e.g.
Figure 2.5 shows the red and cyan colored-filter absorption curves used in this thesis). The
attenuated PDS Cf(A) can be calculated as

Oy =C - F . (2.41)

Through a colored-filter glass, the gamut of a color device is distorted.

2.3.1 The effect of the colored-filter glass on CRT device

This section is very important for developing an anaglyph algorithm for CRT media. As

shown in Section 2.3, a colored-filter glass attenuates a PDS that goes through it. From
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Figure 2.5 The measured absorption curves of the red and cyan filters by using the Ocean
Optics USB2000 spectrometer. This colored-filter glass pair is used in this thesis.

Equations 2.39 and 2.41, the PDS of the emitting light from a CRT display after going
through a colored-filter glass with the absorption curve of f(\) is

Cr(Ax) = C(Ax): f(A) = Tsrercrr(R (%), G (x), B(x)) - f(A)
= R (%) RmazNorm(A, X) - f(A) + G (X) - Gigz Norm (A, X) - f(A) (2.42)
+B (%) * Bnaz,Norm (A, X) - f(A).

Thus the PDSs R0z Norm (A X)- f(A), Ginaz Norm (A, X)- £ (), and Byuaz Norm (A, X)- f(A) can be
considered as three primaries for this filter. By converting these three primaries into the
CIE XYZ tristimulus values, we can get the transformation matrix Apjier, that describes the
relationship between the input signal and the CIE XYZ tristimulus values of the perceived
color through this filter

Cf,X R Rmax,f,X Gmax,f,X Bmax,f,X R
Of,Y = AFilter : G = Rmax,f,Y Gma;r,f,Y Bmax,f,Y ' G ’ (243)
Of,Z B Rmaa:,f,Z Gma;r,f,Z Bma:v,f,Z B

where (Ryaz, 1.5 Rimaz, 1y, Rmaz,r,2z) are the CIE XYZ tristimulus values of the color | Ry,z Norm
(Ax)-f(A)]. Figure 2.6 shows the gamuts of the EIZO CRT monitor, of the red filter, and of
the cyan filter in the xy chromaticity diagram. These two filters have the absorption curves

as shown in Figure 2.5).
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Figure 2.6 The large triangle is the gamut of the EIZO CRT monitor. The small triangle at

the bottom right is the gamut when seen through the red filter. The small upper left triangle

is the gamut when seen through the cyan filter. (Background chromaticity diagram generated
using software of from [2])

2.4 Summary

This chapter has overviewed the color theory necessary for this thesis research. Two types of
color models have been discussed. The colorimetric model (with the CIE XYZ color space
as its representative) models the colors under the same viewing conditions. This model
however cannot predict if two colors will look the same if each of them is in different viewing
conditions. This limitation led to the introduction of the color appearance model (with the
CIELAB color space as its representative). The definition of color distance, that is used
to measure the closeness of two colors, is extremely important in this study. The chapter
also looked at different approaches for establishing the spectral forward characterization
functions of a given CRT and a given printer. The last section showed the attenuation effect

of a colored-filter glass on the CRT display or the printer.
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Mathematical formulation for anaglyph stereoscopic

rendering

THE PREVIOUS CHAPTER is necessary to understand color which is needed for this chapter.
In this chapter, we will systematically formulate the anaglyph problem. Through the for-
mulation we will be able to establish three quality factors for an anaglyph algorithm. These
quality factors can be considered as guidelines for comparison between different anaglyph
algorithms or for developing better anaglyph algorithms. Finally, the chapter will summarize

the state of art of existing anaglyph algorithms.

3.1 Binocular Vision

The two following sub-sections is needed to help us define the limitation of the anaglyph
technique (Section 3.2).

3.1.1 Correspondent points

The human eye in the simplest form can be represented by the Pinhole model as shown in
Figure 3.1(a). The real scene points P, and P; are captured to become the points Pp; and Py
respectively on the 2D left image plane (referred to as left-perspective image) and to become
the points Pr; and Pro on the 2D right image plane (referred to as right-perspective image).
If the left-perspective image is seen only by the left eye and the right-perspective image is seen
only by the right eye then the human brain will fuse these two images into one stereo image
and therefore the observer can perceive the depth of P, and P, as demonstrated in Figure

3.1(b). These two images form a stereo image pair of the real scene. Refer to Appendix

28
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Figure 3.1 (a) The Pinhole model and (b) depth perception reproduction.

B for examples. The points Pr; and Pg; are referred to as the correspondent points of P;.

Similarly, the points Pro and Pgo are referred to as the correspondent points of Ps.

3.1.2 Dichoptic color mixture

Dichoptic color mixture is what the human brain will interpret when one color is presented
to one eye and another color is presented to the other eye. Under some circumstances,
the human brain will fuse these two colors to give an impression of a stable third color.
However, under other circumstances, the brain can’t combine these two colors into a single
color impression but instead will see one color, either the left or the right color, for a period of
time and then see the other color also for a period of time. In other words, we see two separate
colors alternately. We only found one quantitative model that can predict the dichoptic color
mixture in certain restricted conditions, the Dichoptic ATDN model [15]. It has been known
that [15] the dichoptic color mixtures are more stable when (1) the luminances of two colors
are low and equal, (2) the saturations of the two colors decrease, (3) the background is dark

and uniform, (4) the two color stimuli are small in diameter.

3.2 Anaglyph framework

A stereoscopic display system needs to present the left and right-perspective images to the
corresponding eyes. The anaglyph stereoscopic display system uses the color-multiplexing
technique to superimpose the left and right-perspective images into one single so-called
anaglyph image. When the observer views this anaglyph image through a pair of colored-

filter glasses with each eye having a different colored-filter glass (e.g. the left eye wears a red
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filter and the right eye wears a cyan filter) then the left eye will see an image which looks
similar (but not identical) to the original left-perspective image and the right eye will see an
image which looks similar (but not identical) to the original right-perspective image. In other
words, the left colored-filter glass will block the right-perspective image to the left eye and
the right colored-filter glass blocks the left-perspective image to the right eye. From these left
and right filtered images the observer’s visual system will fuse them into one single view with

depth perception. The following section formulates the anaglyph process mathematically.

3.2.1 Anaglyph problem formulation

In this section, we would like to re-address the anaglyph technique from a mathematical
point of view. These formulae are important for understanding the problem systematically
and also serve as a framework for developing and evaluating anaglyph algorithms in later
chapters. This formulation is an extension of the idea in reference [16] and hence this section

and its subsections can be considered as the first contribution to this research area.

An anaglyph stereoscopic display system usually includes an output color device ® such as
a CRT display or a printer, a pair of colored-filter glasses through which the eyes look at the
device ©, and a stereo image pair. Without loss of generality, lets assume that the device ®
is a RGB color device whose input signal d (Figure 2.4) is set of a three values (R, G, B),
that has SFCF of Ygpcr(+) and color gamut of Cg. The left-perspective image in the stereo
image pair, denoted as Iy rep, can be considered as a set of digital inputs d = I, grap(x) =
I reB.R(X) I RGB.G(X) IL RGE B(X)| for each point x € £, where £ is the sampling raster
for the left-perspective image and can be either spatial or spatiotemporal. Similarly, the
right-perspective image Ir rep is a set of digital inputs I pap(X) = [Ir reB.R(X) IR RGE,G(X)
Ir rep,p(x)]. The signal values in Iy, rep(x) and Ig pep(x) are in the range of [0, 1]. Assume
that the left eye sees the device ® through the left colored-filter glass (left filter) that has the
absorption curve f()\), and the right eye sees the device © through the right colored-filter
glass (right filter) that has the absorption curve fr(\).

If the device ® displays the inputs I, rop(x) and Ig pep(x), individually, then the perceived

colors at a point x are
I\, x)] = [Ysrer (I rap(X))],
Ir(X,x)] = [Ysrer(Ir rap(x))].

An anaglyph algorithm Ya,,(-) will have to render an image, called the anaglyph image,

(3.1)

denoted as I4 rap, from I, rep, Ir rae, and other information such as the absorption curves
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of the two filters, the characteristic of the device ®, and probably the viewing conditions:

Iirae = TanaIrres, Irras, fu(N), frR(A), Tsecr(:), -..). (3.2)

The anaglyph algorithm Y s,,(-) may not be a memoryless system. Lets assume the input

I4 rep(x) has three components as

Iires(X) = [ Inresr(X) Iarec(X) Iaress(X) ). (3.3)

If the device © displays the input I4 rep(x), then the perceived color by both eyes without

glasses is
[Ta(N,x)] = [Tsrer(Ia,res(x))]. (3.4)

Through the left filter, the left eye sees the color

[Lar(Ax)] = [Tsrer(Ta,rep(x)) - fL(M)] = [La(A x) - fLA)], (3.5)
and through the right filter, the right eye perceives the color

[Tar(A\,x)] = [Tsrcr(Ta,ras(X)) - frR(N)] = [Ta(A, %) - frR(N)]. (3.6)

For convenience, lets assume that the CIE XYZ tristimulus values of colors [IL(\,x)],
[Tr(N, x)], [Ta(A,x)], [Tar(N, x)], and [Tag(A, x)] are

I XYZ(X) [ IL,XYZ,X(X) IL,XYZ,Y(X) IL,XYZ,Z(X) ]:
Irxyz(x) [ Inxvzx(X) Ipxvzy(X) Irxyvzz(X) ]
Iaxyz(x) [ Taxvzx(X) Taxvzy(X) Iaxvzz(x) ] (3.7)
Lipxyvz(x) = [ Tapxvzx(X) Tapxvzy (%) Tapxyvzz(x) ],
[

—~

IAR,XYZ,X X) IAR,XYZ,Y(X) IAR,XYZ,Z(X) ]

Ideally, if the left and right perceived colors [I47 (A, x)] and [I4r(\, x)] are identical to the
ideal colors [I1,(\, x)] and [Ig(A, x)] respectively, then we have a perfect 3D perception. This

is, in fact, impossible to achieve as shall be proved in the next section.

3.2.1.1 Conditions for the colored-filtered glasses to perceive 3D perception

Obviously, the color [I41(), x)] has to be different from [I4r(), x)] at least at some points x;
otherwise, both eyes will see the same image, thus destroying the binocular vision principle.
In order for [I41(\,x)] to be different from [I4z(\,x)], from Equations 3.5 and 3.6, the
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absorption curve fr(\) has to be different from fz(A). Furthermore, due to the parallax in
the stereoscopic image pair, it requires that at some locations the luminance of [I41 (A, x)]
must be greater than that of [I4g(),x)], and vice-versa [16]. For example, the left ICIP
stereo image (Figure B.2) is dark at the pixel x(862, 666) in the interesting region ICIP1
(Figure B.5(a)) while the right ICIP stereo image has high luminance at this point. This
implies that the absorption curves fr(A) and fr(\) must have some non-overlap bands and

satisfy the following conditions

fo(A) > 0and fr(A) >0 if A € By,
fr(A) = 0and frR(\) =0 if A € Bg, (3.5)
fr(A) >0and frR(A\) =0 if A€ By,
fr(\) ~ 0 and fr(A) >0  if A € Bp,

where BoNBgNB,NBr = 0 and BoUBrUBLUBR = [Muin, Amaz|- We refer to the bands By,
and By as independent bands. For example, for the red (on the left eye) and cyan (on the
right eye) colored-filter glass pair whose absorption curves are shown in Figure 2.5, the band
By, is [590 nm, 700 nm| and the band By is [400 nm, 590 nm|, while the bands By and B can
be considered as overlap and empty respectively. Thus, to have, for example, low luminance
in [141 (A, x)] and high luminance in [[45(\,x)] (in the case of the example above) then the
PDS I4(A,x) has to be chosen such that it has low power in 5, and high power in Bg.

The effect of the band Br would be on the left and right filter gamuts. As Bpg increases,
the two filter gamuts will be reduced. Therefore, we would like to have Bg to be empty. To

see the effect of the PDSs in the bands Bp, By, and Bg, let us compute I4;, xyzy(x) and

IAR,XYZ,Y(X) as

Am(lﬂ')
Lirxvzy(x) = [ La(x) - fr(A) - G(A) - dA
Amin
= ] LapoAx) - fuN) g -dA+ [ Las, (M%) - () - F(A) - dA,
AEBo AEBL
(3.9)
Am(lil)
Iarxyzy(x) = f La(A,x) - frR(A) - G(A) - dA
Amin
= TasoAX) - frN) TN -dA+ [ Laga (A %) - fr(A) - H(A) - dA,
XeBo AeBr
(3.10)
T4(A if A € B
where 14 5,(\, %) = A x) i 9 Similar expressions hold for T4, (N x) and

0 it \ ¢ Bo
I48,(A,x). From the two Equations 3.9 and 3.10, as 14 5, (), x) increases the luminances of
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the colors perceived in both eyes also increase. Therefore, the PDS I4(\,x) effects on the
colors that perceived by both eyes. In order for 14;, xyzy(x) to be adjusted independently
with I4r xyzy(x) and vice versa, we need the device ® to be able to adjust 14z, (A, x)
independently with 14 g, (A, x) and vice versa. This condition often does not hold for many
color output devices since the PDS I4(\, x) tends to be broad, as in the case of the EPSON
printer (Chapter 6).

3.2.1.2 Generic anaglyph algorithm

Given a colored-filter pair that satisfies the conditions in Equation 3.8, an anaglyph algorithm
can be seen as two mapping functions in which one maps [I;(\,x)] to [[41(),x)] and the
other one maps [Iz(A\,x)] to [Iag(\,x)]. Due to the properties of the absorption curves
fr(A) and fr(\), the left and right filter gamuts are different from each other and also
different from and smaller than the original device gamut. Furthermore, let [/ (), x;)] and
[Ir(X, x2)] be a correspondent pair (Section 3.1.1) so that I1,(\,x1) B 1g(\, x2). Through the
anaglyph algorithm, the color [I1,(\,x1)] is mapped to [I4 (A, x1)] and [Ir(), X2)] is mapped
to [[ar(A, x2)]. If we assume that the dichoptic color mixture can be modeled by a function

T bichoptic(+) then the dichoptic color mixture that we perceive is

[L4 Dichoptic) = Y bichoptic ([Lar(A, X1)], [Lar(A, x2)]), (3.11)

and we would like [I4 pichoptic] B In(A,x1) B Ir(A,%x2). One trivial case for this to happen
is that I (A, x1) B Iar(A,x1) and Ig(X,x2) B Lag(A, x2). However, this trivial case in not
possible due to the conditions of colored-filter glasses. We can only make I4 pichoptic close
to [/L(A\,x1)] and hence this introduces color distortions. The function Y pichoptic(+) can be

derived from the two mapping functions.

3.2.1.3 Anaglyph quality factors

As discussed in Section 3.1.2, not all pairs of two distinct colors will give a third stable
perceived color, and thus the mapping not only has to ensure that the dichoptic color mixture
[L4 Dichoptic) is as close as possible to [I1, (), x1)] to reduce the color distortion, but also should
give a dichoptic color mixture [L4 pichoptic] that is stable. Also due to the dependency between
the PDS 145, (A, x) and the PDS 14 5, (A, x), the anaglyph suffers to the ghosting effect (or
crosstalk), in which partial information of the left image leaks into the right eye and wvice-

versa.

The ghosting effect and the rivalry effect will cause a degradation in the 3D effect, whereas
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the color distortion will control the color fidelity (the set of colors that can be perceived
through dichoptic color mixing phenomenon) of the perceived 3D scene. Thus the quality of
an anaglyph stereoscopic system can be judged based on these three aspects, referred to as

three anaglyph quality factors: ghosting effect, color stability, and color fidelity.

3.2.2 Anaglyph design problems

There are three design problems for an anaglyph stereoscopic display system: (1) For a
given color output device, what are the best absorption curves f;(\) and fr()), (2) For
given absorption curves fr(A) and fr(\), what is the best color output device, and (3) For
given color output device and absorption curves f(A) and fr(\), what is the best mapping
function to minimize the ghosting and color rivalry effect while increasing the perceived color
fidelity. In this study, we mainly focused on the third problem. No literature that addresses
the problems 1 and 2 has been found. In any case, the solution depends on the solution to

problem 3.

3.3 Test stereo image pairs

In order to test different anaglyph algorithms, three different stereo image pairs were chosen,
as shown in Appendix B. They are REDCAR, ICIP, and BEAR stereo image pairs. Each

of the pairs has interesting regions that we want to pay particular attention to.

3.4 Overview of common colored-filter glasses

Even though no formulation has been developed for finding the best filter pair, in practice,
the colored-filter glasses are chosen empirically. For a given CRT display, the red phosphor
PDS Ruz[A, x| is mostly concentrated in the range of [7600 nm, 700 nm|. Similarly, the
green and blue phosphor PDSs G4 [\, x] and B[\, x| mostly concentrate in the range of
[7500 nm, ~600 nm| and [400 nm, ~500 nm]| respectively. Thus to minimize the ghosting
effect on a CRT display, the absorption curves fr,(\) and fg(\) can be chosen such that the
band By, = [7600 nm, 700 nm| and Bg = [400 nm, ~600 nm| (also called red-cyan filters, as
shown in Figure 2.5) or By, = [7500 nm, ~600 nm| and Bz = [400 nm, ~500 nm|U[~600 nm,
700 nm| (also called as green-magenta filters) or By, = [500 nm, ~700 nm| and B = [7400
nm, 500 nm| (also referred to as yellow-blue filters, as illustrated in Figure 3.3). In these

cases the bands Bp and Bg are 0.
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The choice of which pair out of these three filter pairs above should be used depends on
applications. As pointed out by Sorensen et al. [17], yellow-blue filter pairs often give a very
large range of the dichoptic color mixture [I4 pichoptic] at the expense of strong imbalance
between the luminances of [I41(\, x)] and [[4r(A, x)]. Green-magenta filter pairs often give
the best in term of luminance balance between the left and right views. Red-cyan filter pairs
often give better left right luminance balance but the range of the dichoptic color mixture

(L4 Dichoptic] tends to be small.

3.5 Overview of existing ghosting effect measurements

As mentioned, the ghosting effect is the result of the correlation between [I4. (), x)| and
[Tar(\, x)]. Woods et al. [18] provided a simple ghosting analysis to quantitatively calculate
this correlation. For a given particular CRT display and a particular colored-filter glass
(the red-cyan filters used in this paper), the amount of ghosting can be calculated by first
displaying the red spectrum at its maximum intensity (by setting the input d = (1, 0, 0))
and then through the cyan filter measuring the area under the attenuated PDS, denoted as
ARed,Cyan-Filter; @ Well as through the red filter measuring the area under the attenuated PDS

curve, denoted as ARed Red-Filter-

Similarly displaying the cyan spectrum at its maximum intensity (by setting d = (0, 1,
1)) and then through the red filter measuring the area under the attenuated PDS curve,
denoted as Acyan,Red-rFilter, and through the cyan filter measuring the area under the at-
tenuated PDS curve, denoted as Acyan,cyan-rilter- Lhen finally, the percentage of the ratio
ACyan Red-Filter/ ARed,Red-Filter 15 the percentage of the amount of leaking information from the
right stereo image into the left eye (with the red filter) and similarly the percentage of the
ratio Aged,Cyan-Filter/ ACyan,Cyan-Filter 15 the percentage of the amount of leaking information

from the left stereo image into the right eye (with the cyan filter).

3.6 Overview of existing anaglyph algorithms

Not many anaglyph algorithms have been developed and most of them are very empirical
[16]. To the best of my knowledge, all the known existing anaglyph algorithms are developed
for CRT displays. The following subsections are the overviews of each existing anaglyph
algorithms designed for a CRT display ®©. We assume this CRT has the transformation
matrices Ay for the left filter, Ag for the right filter, and the transformation matrix A
(Section 2.3).
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3.6.1 Photoshop algorithm

The most popular algorithm for rendering an anaglyph image is the so-called “Photoshop
algorithm” which is described in detail by Turnnidge et al. [19]. In the Photoshop algorithm,
one of the coefficients in the input I, pep(x) is taken from the input I grep(x) and the
remaining two coefficients are taken from the input Ig rep(x). If the colored-filter pair

glasses are red-cyan filters, then the input I4 rep(x) can be established in matrix notation

as
[L,RGB,R(X)
I1 reB.c(X)
[A,RGB,R(X) 1 000 0O I (x) [L,RGB,R(X)
L,RGB,B
IA,RGB,G(X) = 00 O0O0T1@O0 I (X> = [R,RGB,G(X>
R,RGB,R
IA,RGB,B(X) O O O O O 1 IR,RGB,B(X)
Ir reB.G(X)
| IrreB,B(X) |
(3.12)
Similarly, for green-magenta filters the anaglyph input I4 pep(x) is
I rB,R(X) I reB.c(X)
Inrepc(x) | = | Iprer(xX) |, (3.13)
14 reB B(X) Ir rcB.B(X)
and for yellow-blue filters the anaglyph input I, rep(x) is
14 reB.R(X) I}, reB R(X)
Iyrepa(x) | = | Inrepa(x) |- (3.14)
14 reB B(X) I reB.B(X)

Clearly, the Photoshop algorithm doesn’t take the absorption curves of the filters into the
production process. A derived version of the Photoshop algorithm would be to replace

I, rep r(X) by the grayscale of the left view for red-cyan filters as

Ir raB,G(X

]L,RGB,R(X)

1 X

IarcB.R(X) 0.299 0.587 0.114 0 0 0 IL’RGBvGE ;
X

X

T4 reB.B(X) 0 0 000 1 R,RGB,R()
(x)

Ir raB,B(X
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There are many free and shareware programs that render anaglyph images from stereo image
pairs, including StereoPhotoMaker [20], AnaMaker [21|, AnaBuilder [22]. Although there is
usually no explicit indication of what anaglyph algorithm is used in these programs, the
anaglyph images generated from the first two programs are very close to the ones generated
from the Photoshop method implemented in MATLAB. This suggests that these two pro-
grams use the Photoshop algorithm while AnaBuilder implements the LP method which will

be discussed in a later section.

The resulting anaglyph images of the three test stereo image pairs rendered by the Photoshop
method are shown in Section C.5. All three anaglyph images for red-cyan filters show strong
color rivalry overall (e.g. in the interesting region REDCAR2), since it doesn’t replace the

red-like colors by more stable colors as in the LP method.

3.6.2 Midpoint algorithm

The anaglyph Midpoint algorithm [23| computes in the CIELAB color space a point O which

is the midpoint of the line joining the two colors I xyz(x) and Igg xyz(x) where

I%L,XYZ(X) =ApL- Iz,RGB(X)v
I%R,XYZ(X) = Apg- I%,RGB(X)'
First, transform I, xyz(x) and Izg xyz(x) from the CIE XYZ color space to the CIELAB

color space by using Equation 2.21 with D65 as the reference white point to obtain

(3.16)

Inprae(X) = [ Inprabn(X) Iopraba(X) Ionravs(X) 1,

(3.17)
IRR,Lab(X) = [ IRR,Lab,L(X) IRR,Lab,a(X) IRR,Lab,b(X) ]
Then the color point O in CIELAB space is
T4 0a(x) = (Ip,2ab(X) + Ir Lab(%))/2. (3.18)

Finally, convert I 1.(x) back to I4 yyz(x) and then I4 rep(x)=A 114 xyz(X).

The resulting anaglyph images of the three test stereo image pairs rendered by the Midpoint
method are shown in Section C.6. The BEAR and ICIP anaglyph images for red-cyan filters
show very strong ghosting effect which completely destroy the 3D perception. The results

are very poor.
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3.6.3 Linear Projection algorithm

Dubois [16| proposed a new approach for obtaining an anaglyph image. This method is
referred to here as the Linear Projection (LP) method. In the ideal case, we would like the
left eye to see the color [I,(A, x)] and the right eye to see the color [Ir(), x)]. The CIE XYZ

tristimulus values of these colors can be computed in matrix notation as

IL,XYZ(X)T =A- IL,RGB (X)T7

(3.19)
IR,XYZ(X)T =A- IR,RGB(X)T-
Arranging Equation 3.19 we have
I T A O I T
L,XYZ(X)T _ ) L,RGB(X)T —A,- V(x),
I xyz(X) 0 A Iz raB(x
A O 0 0O
AQ:[ ],0: 00 0|, (3.20)
0 A
0 0 O
I
V(x) _ L,RGB(X)
IR,RGB(X)

However, with an anaglyph system the left eye would see [14(\,x)] and the right eye see
[I4ar(\,x)], and the CIE XYZ tristimulus values of these two colors can be computed in

matrix notation as
Tarxyvz(x)" = AL - Tarep(x)7,

(3.21)
IAR,XYZ(X)T =Ap- IA,RGB(X)T-
Again by rearranging the equation above
I T A
ARXYZ R (3.22)

A
R = [ g ] .
Ap
The main objective here is to find I4 pep(x) such that [I47 (X, x)] and [Iag(A, x)] are as
similar as possible to [I (A, x)] and [Ig(\, x)], respectively. In other words, we want the color
distances between [I47 (A, x)|, [I1 (A, x)] and between [I4r(\,x)], [[r(\,x)] to be minimal (

Figure 3.2). The LP’s author chose the Euclidean distance in CIE XYZ color space (Equation

2.18) as the error metric. Therefore, the optimization problem can be stated as finding the
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Figure 3.2 The LP algorithm. Points 1, 2, 3, and 4 represent for colors [I,(\,x)], [Ir(\,x)],

[Tar(\,x)], and [Iar(\,x)], respectively. The LP algorithm tries to find the total shortest

distances between points 1, 3 and points 2, 4. (Background chromaticity diagram generated
using software of from [2])

anaglyph input I4 gop(x) as

14 reBopt(X) = arg  min

{ AEXyz(ILXYZ( ),IALXYZ( )) }

iree(®) | +AExyz(Irxvz(X),1arxyvz(X))
A O I T A
=arg min . L’RGB(X)T - . Lires(x)"| p. (3.23)
I4,rcB(X) 0 A IR,RGB (X) AR

The solution for this optimization problem can be obtained by using the projection theorem

[24]. The matrix V(x) can be seen as a vector in the six-dimensional space Sg which has
the six column-vectors of the matrix A, as basis vectors. Similarly, the matrix I4 pep(x) is
a vector in the three-dimensional S; with the three column-vectors of the matrix R as basis
vectors. The space Sz is a subspace of Sg. From the projection theorem, the optimal vector

I4 rep(x) can be obtained by projecting the vector V(x) onto subspace S; and the result is
Lirce(x)" = (RTWR)™' - RTWA, - V(x), (3.24)

where W is a 6x6 positive-definite weight matrix. The resulting coefficients in I4 pop(x)
are not in the range of [0, 1| but often greater than 1. This is because the luminances of
4z (A,x)] and [I4r (), x)] are attenuated by the filters. The projection method in fact tries to

compensate this attenuation by increasing I4 pep(x). However, the CRT can only generate
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the maximum luminance when the input is [1, 1, 1] thus we need to normalize I4 rep(x)
to bring each component into the range of |0, 1]. The simple clipping normalization does
not work well. The paper [16] suggested that I4 pep(x) can be normalized according to the

white point. Let
E=[Fr Ec Ez]"=R'WR)"'-R"™WA,-[1 1111 1] (3.25)

be the result of applying the raw projection algorithm 3.24 to a white point in both left and

right original colors. Then we set

Lirep(x)! =N (RTWR)™ - R"WA; - V(x) =B - V(x),
1/Ex 0 0
N=| 0 1/Ec 0 |,
0 0 1/Bg

(3.26)

sothat [1 1111 1] maps to [1 1 1]. Finally, we clip any out of the range |0, 1| components
in Iy rep(x). In the case of the EIZO CRT monitor with the red-cyan filters, the resulting
matrices Ay, Ag, A, B, and N are:

0.1802 0.0243 0.0095 0.0138 0.0999 0.1892
Ap =1 0.0797 0.0150 0.0030 |, Agr= [ 0.0208 0.3533 0.0865 | ,
0.0008 0.0020 0.0275 0.0317 0.1271 1.0464
0.3303 0.3255 0.2708 0.1671 0 0
A= 0.1848 0.6967 0.1184 |, N = 0 0.4108 0 , (3.27)
0.0422 0.1603 1.4109 0 0 0.8600
0.3224  0.4951  0.2534 —-0.0121 —0.0472 —0.0115
B=| —0.0436 —0.0616 —0.0460 0.2847  0.8588  0.0077

—0.0393 —0.0606  0.0017 —0.0009 -0.0614  1.1605

The introduction of the white-point normalization vector N and the final clipping action
cause the anaglyph input I4 rep(x) to no longer be the optimal solution of the objective
function 3.23 (Note that this white-point normalization is different with the spectral white

point normalization in Section 2.2.3).

The resulting anaglyph images of the three test stereo image pairs rendered by the LP
method, where the matrix W is a 6x6 identity matrix, are shown in Section C.7. Overall
it is very comfortable to view all three anaglyph images for red-cyan filters. All the red-
like colors in the original REDCAR (e.g. the interesting region REDCARS3) are replaced by
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Figure 3.8 The measured Color-Code absorption curves by using the Ocean Optics USB2000
spectrometer.

dark-yellow-green like colors. This special feature gives better visual comfort in the anaglyph
images. However, the perceived 3D image is seen to be greener compare to its original
images. The biggest limitation in the LP method is that it suffers from the ghosting effect
as represented in all three anaglyph images, especially in the interesting regions REDCARS3
and [CIP1. The LP method so far is the best available in existing anaglyph algorithms.

3.6.4 ColorCode algorithm

Another well known algorithm based on the Photoshop algorithm is presented in Sorensen
et al. [17] and is called ColorCode. Instead of using red-cyan filters, ColorCode suggests
to use a yellow-blue filter pair whose absorption curves are shown in Figure 3.3. The idea
behind the ColorCode method is that if one eye sees a view that retains all the colors while
the other eye sees a view that is in monochrome then the fused 3D image is most likely to
give a full color range perception. The yellow filter basically allows most of the colors to
go through while the blue filter gives a nearly monochrome image; therefore the yellow-blue
filters let the observer see most of the colors, and more than other colored-filter glasses. For
example, a red color most likely is seen as black if looking through the red-cyan filters but

it remains as a red if the yellow-blue filters are used.

For the given yellow-blue filters, the process of producing an anaglyph image by using the

ColorCode method basically consists of two steps: (1) applying a linear mapping with matrix
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B
100 0 0 0 100 0 0 0
B=|010 0 0 O|looB=|010 0 0 0}, (328
00 0 011 0.22 0.67 00 0 017 0.17 0.66

to give an anaglyph image I4 pep(x)”= B-V(x) which will have a substantial luminance
imbalance between images reaching the observers’ eyes, then (2) perform a color correction
process to the anaglyph image I4 rep(x) just created in the step (1). We can use the
commercial software 3D-EASY?™ [25] to render anaglyph images for the yellow-blue filters.
Even though the ColorCode method offers a larger range in dichoptic color mixtures than
typical red-cyan filters, there is one serious drawback: the luminances of the left perceived
color and right perceived color are very different and this makes it very uncomfortable to

look at, i.e., it has lower visual comfort.

3.7 Summary

Through the anaglyph formulation, the quality factors of an anaglyph algorithm consist
of color stability (whether the overall perceived dichoptic color mixtures are stable or not),
color fidelity (how large is the gamut of the perceived dichoptic color mixtures), and ghosting
effect (the leaking of information of one perspective image into the other eye). Four differ-
ent existing anaglyph algorithms have been overviewed. They are the Photoshop method,
Midpoint method, LP method, and ColorCode method. The LP method is considered as the
best method among those four methods as its resulting anaglyph images offer a good color

stability and color fidelity. However the LP method suffers from the ghosting effect.



CHAPTER
FOUR

Implementation of the CRT monitor and printer SFCF

IN THIS RESEARCH, we would like to develop an algorithm for rendering anaglyph images
which are optimized for a particular output color device type. Due to the popularity, CRT
displays and printers are chosen for this study. To test anaglyph algorithms, it is necessary
to display the rendered anaglyph images on these chosen devices. In this chapter, we would
like to derive the SFCF for a particular CRT display and a printer which we will use for
developing and testing new algorithms. Sections 2.2.5 and 2.2.6 provide procedures for
characterizing the chosen CRT display and printer, respectively. The models are also tested

to ensure their accuracy.

4.1 Apparatus

An Ocean Optics USB2000 spectrometer was used to measure the PDSs of lights emitting
from a CRT display or lights reflecting from a printed paper. Each of measured PDSs has 151
discrete wavelength points taken at 2 nm interval between 400 nm and 700 nm. Appendix
A shows in detail the usage of the Ocean Optics USB2000 spectrometer.

4.2 CRT monitor

The CRT monitor used in this study is the 21”7 FIZO FlexScan F980 CRT monitor. It has
0.23mm Dot Pitch and resolution of 1600x1200 pixels. The monitor was driven by a 24-bit
video card with no profile installed in a dual Intel CPU workstation running Windows 2000.
In this section, we will model the SFCF for this monitor based on steps in Section 2.2.5.

First, the monitor was set to a known state which is the default settings provided by the

43
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Figure 4.1 The measured PDSs of the red, green, blue lights at the mazimum intensity and
the white color. The data was collected by using the Ocean Optics USB2000 spectrometer.

Table 4.1 The xy chromaticities of three primaries of the EIZO CRT monitor.

[Rrnae A X)] | [Grmaz(AX)] | [Gmaz (A X)] | [W(A, x)]
0.5786 0.2773 0.1526 0.2647
0.3325 0.5880 0.0715 0.2287
0.0888 0.1347 0.7759 0.4466

manufacturer (there is a default setting option in the monitor’s menu. When this option
is chosen, all the current monitor settings are changed back to manufacture default setting
values). This default state has the contrast value of 100% and the simulated temperature of
9300 K. All measurements were carried out in a dark room to reduce the flare effect. During
the spectral measurement process, we tried to keep the spectrometer perpendicular to the
monitor to minimize angular effects. MATLAB version 7.0 (R14) Service Pack 1 was used
to control and display colors on the EIZO CRT monitor. In this study, we would like to
skip the temporal stability testing for the monitor by assuming that the characteristic of
this monitor would not be changed during the course of the study and hence only a one-time

calibration and characterization would be needed.

4.2.1 Implementation of the EIZO CRT monitor SFCF

The model Ysper crr(-) described in Section 2.2.5.2 is used to characterize the EIZO CRT
monitor. First, the normalized spectral white-point (Section 2.2.3) Raz(\, X), Gaz (A, X),
Binaz (A, x), and the white color PDS W (A, x) were measured as shown in Figure 4.1 with
their xy chromaticity coordinates given in Table 4.1. The CIE XYZ tristimulus values of the
white point W (A, x) were (0.9268, 1.0, 1.5469). As we can see, the EIZO’s white point is not
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CRT MONITOR

Table 4.2 The normalization values of the EIZO CRT monitor, where i s R, G, or B.

45

imax,Y',Norm imax,Y imax,Y',Norm/imax,Y'
R 0.1891 0.2057 0.9196
G 0.6875 0.7230 0.9509
B 0.1234 0.1272 0.9699
0.08 ‘
Red
0.07r| — — — Green
2 006} Blue
2
S 005t
5]
§ 0.04f
2003} /™
g I _
© 0.02f N
y N4 N
0.01}, A \ 1
/ VAN
0 e . > %Pl [\./\
400 450 500 550 600 650 700

wavelength (nm)

Figure 4.2 The white point normalized PDSs of the red, green, blue lights at the maximum
intensity.

D65. From Equation 237, the values Rma;c,Y,Norma Gmaac,Y,Norma and Bma:v,Y,Norm are giVeH in

Table 4.2. The resulting normalized matrix A in Equation 2.40 is

0.3291 0.3243 0.2634
0.1891 0.6875 0.1234
0.0505 0.1575 1.3389

A= (4.1)

The normalized spectra R0z Norm (A, X); Gimaz Norm (A, X), and Biaz Norm (A, X) are shown in
the Figure 4.2.

The next step is to derive the calibration function. All three calibration models in Section
2.2.5.1 were implemented and tested. For each channel, for instance the red channel, ten
PDS measurements were made, corresponding to the inputs R'= 255, 229, 204, 178, 153, 127,
102, 76, 51, and 25, while the other corresponding values of G’ and B’ were set to 0. In this
way, a total of thirty PDSs were measured. Following Sections 2.2.5.1.1 and 2.2.5.1.2, the
gain and the gamma values were calculated and are shown in the Table 4.3. Here, we used
the MATLAB “fminimaz” routine (Section 6.3) as the optimization method with CIELAB

CIE-94 as the color distance metric.
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Table 4.3 The gain and gamma values in the Simple gamma-correction and the GOG
gamma-correction model for the EIZO CRT monitor.

Model YR G B ker | kg | kgB
Simple | 1.7959 | 1.9113 | 1.9104 | n/a | n/a | n/a
GOG 1.7959 | 1.9108 | 1.8477 | 1.0 1.0 | 1.013

Table 4.4 The performance of three different gamma-correction models applied for the EIZO
CRT monitor.

Spectral RMS

Model | Mean (><10_2) Max (X10_2) Std. dev. (X10_2)
Simple 0.0534 0.1114 0.0298
GOG 0.0530 0.1114 0.0305
ITU 709 0.0640 0.1279 0.0347
AEg4
Model | Mean | Max | Std. dev.
Simple 1.3891 | 7.3280 1.0

GOG 1.3521 | 6.4270 1.0439
ITU 709 | 1.1849 | 3.2824 0.5279

4.2.2 Model accuracy test for the EIZO CRT monitor

Once Ysper,crr(-) was obtained, we tested it to determine the accuracy of the obtained
function. A patch of 50 gamma-corrected inputs d'res; where each has coefficients (R Test,
G'Test, B'Test) were displayed on the EIZO CRT monitor and their PDSs were measured. At
the same time, the estimated PDSs versions of those test inputs could be obtained by first
using each of the gamma-correction models to invert those values into non-gamma-corrected
values (Rrest, Gest; Best), and then applying Equation 2.39 on these non-gamma-corrected
inputs to get the estimated PDSs. The errors between the measured PDSs and the estimated
PDSs tell us the accuracy of the SFCF and the gamma-correction models. Both of the color
distance metrics CIELAB CIE-94 and the spectral RMS (root-mean-square) were used as
the error metric. The spectral RMS is defined as

151

Z (CEstimated[)\i] - CMeasured [)\z])Q

MS = | &L . 4.2
RMS i (4.2)

These fifty test gamma-corrected inputs were randomly drawn from a uniform density. Table
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4.4 gives the error results. We can see that, the GOG model gives the best accuracy in terms
of the difference between the measured spectrum and the estimated spectrum. Since what
we want is SFCF, therefore, we will use the GOG gamma-correction model as the gamma-
correction model for the EIZO CRT monitor.

4.2.3 The effect of the colored-filter glasses on the EIZO CRT mon-
itor

With the normalized PDSs of the primaries of the EIZO CRT monitor obtained, based on
Section 2.3.1 the effect of the colored-filter glasses on this monitor can be described by the
transformation matrix Apje.. For example, for a given input displayed on the EIZO CRT
monitor, the CIE XYZ tristimulus values of the perceived color through the red and cyan
filters whose transmission absorption curves are shown in Figure 2.5 can be calculated by

the two matrices Ageq and Acyan, Where

[ 0.1764 0.0250 0.0110 |
Agrea = | 0.0782 0.0152 0.0038 |,
| 0.0010 0.0020 0.0260 |
[ 0.0155 0.0987 0.1802 |
Acyn = | 0.0241 0.3470 0.0872
| 0.0380 0.1247 0.9937 |

4.3 RGB Printer

The printer used in this research is an EPSON Stylus Photo 2200. It has seven pigment-
based colorants: cyan, magenta, yellow, black, light cyan, light magenta, and light black.
The resolution can go up to 2880x1440 dpi and the paper size is up to 13” widex44” long.
The chosen paper that was used with the EPSON printer is a high-quality EPSON semigloss
photo paper. The Adobe Photoshop 6.0 program was used to control the printing process
and the printer’s driver are installed in an Intel workstation running Windows XP Service
Pack 2.

4.3.1 EPSON printer characterization implementation

To apply the model-based characterization (Section 2.2.6) on the EPSON printer, we need
to be able to access to the seven digital values that control the amount of each colorant
that needs to be applied to the paper. However, the driver that goes with the EPSON
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printer doesn’t have such a feature. Therefore, to apply a model-based approach we need a
custom driver to control printer. This is the approach used in Taplin’s study [26]. However,
to simplify the process, we decided to go with the empirical characterization method by
treating the whole EPSON printing process as a black box, where its Yspcr printer() needs
to be characterized. Yspop printer(-) has the input as a set of three signals 0<R, G, B<1 in
sRGB color space and the output is the PDS C'(\) with Ay KA Az

4.3.1.1 The EPSON printing process

The input of the printing process is assumed to be three values (R, G, B) in sRGB color
space. This is because of the popularity of the JPEG format in sSRGB. The following steps
are applied for the EPSON printer to print an input image (here we assume that Adobe
Photoshop and the EPSON printer driver are installed and working properly):

1. Open the image in the Photoshop program.

2. On Photoshop menu, choose Image > Mode > Assign Profile. On the opened dialog,
click on the Profile radio button and choose the profile name sRGB IEC61966-2.1.

This action in fact is to ensure that the image is in SRGB color space.

3. Choose File > Print Options, and on the opened “ Print Options” dialog click the “ Page
Setup” button.

4. On the opened “Page Setup” dialog, choose the “EPSON Stylus Photo 2200” printer.
Then click on the “Properties...” button.

5. On the opened “EPSON Stylus Photo 2200 Properties” dialog, make sure the dialog is
in the “Main” tab, then click the “Advanced” button.

6. On the “Paper & Quality Options” area choose these settings: “Premium Semigloss
Photo Paper”, “SuperPhoto - 2880dpi”. This step tells the printer to choose the correct
paper which is the EPSON photo premium semigloss paper. On the “Color Man-
agement” area, check the “ICM” radio button. Then on the ICC Profile, check “No
Color Adjustment” radio button. The “No Color Adjustment” option will tell the driver
not to apply the color adjustment procedure, since Photoshop will perform the gamut

mapping based on the profiles.

7. Click “OK” button to go back to “Print Options” dialog. Check “Show More Options”
option and this will extend the “Print Options” dialog.
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Table 4.5 The input values in the target chart that has a total of 10x 12x7 = 840 training
samples.

Steps
R |0 |45 ] 75 | 100 | 125 | 150 | 175 | 200 | 230 | 255
251 50 | 75 | 100 | 125 | 150 | 175 | 200 | 215 | 240 | 255
B | 0] 50| 100 | 150 | 200 | 225 | 255

Q
o

8. Choose the “Color Management” option. Make sure that on the “Source Space” area
the “Document: sRGB IEC61966-2.1” radio button is checked. On the “Print Space”
area choose the “SP2200 Premium Semigloss PK” on the “Profile” drop off box and
choose the “Perceptual” on the “Intent” drop off box. This step chooses the perceptual
intent (Section 2.2.4) for the gamut mapping and assigns correct output profile to the

printer.

9. Finally, click the “Print” button to print.

4.3.1.2 Determination of the EPSON printer SFCF

Similar to the EIZO CRT monitor, we assume that the characteristics of this EPSON printer
do not vary much during the course the study, and that the printer has been pre-calibrated
by the manufacturer. This thus allows us to skip the calibration process. As mentioned
in Section 2.2.1, the empirical method applies data fitting and interpolation technique on
a large enough set of input color samples and measured output samples. In this section,
four different interpolation techniques are investigated: polynomial regression, tri-linear in-
terpolation, sequential interpolation, and neural network (Section 2.2.2). At the end we will
choose which technique is the best for the EPSON printer.

The input vector d; = |[R; Gy By for the interpolation has size of m = 3, and the size of
the output vector c; is n = 151 corresponding to 151 discrete wavelength points. A patch
of T = 840 training sample inputs (also referred to as target chart which is included on the
attached CD) chosen to lay on a rectangular lattice with the coefficient values of the inputs,
as presented in Table 4.5, was generated. By following the EPSON printing process described
in Section 4.3.1.1, we first printed the target chart and then measured the reflecting PDSs
from each colorant mixture in this printed target chart using the Ocean Optics USB2000
under fixed illuminant light. These reflecting PDSs are further performed the spectral white-
point normalization, where the printer white point is the color of the paper (without any

colorant mixtures) under the illuminant light and it is in the 840 training sample inputs.
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Figure 4.8 The measured PDSs and associated estimated PDSs from order-5 polynomial,
trilinear, and sequential for two different inputs (a) RGB=(0.4863, 0.7725, 0.4824) and (b)
RGB=(0.6274, 0.1961, 0.8745).

The illuminant light used for this study is commercial 60W incandescent light bulbs. Each
of the coefficients in the output vector is modeled independently from the other coefficients.
For the polynomial regression technique, the order of 5 was chosen. For the neural network,
the three-layer feed-forward structure was chosen with 10 nodes for the first layer, 10 nodes
for second layer and 151 nodes for the third layer. Figure 4.3 shows the measured PDS
and associated estimated PDSs for each of the interpolation technique (except the neural

network).

The accuracy of the model depends on the selection of the input training samples. We want
to lay more input sample training points at certain nonlinear regions of the SFCF within
the gamut to refine the function. However, we didn’t really know in which regions of the
gamut the characteristic function exhibits nonlinear characteristic. So refinement can be
done through a multi-stage design, with a rearrangement of the training samples based on
the previous modeled SFCF. In this study, we decided not to do the refinement process.
Instead, because the HVS seems to more sensitive to the green component than to blue and
red components [17], it would be a good idea to have more steps in the green stimulus set.
In this study, we didn’t investigate the effect of the number of colors in the target chart
used since the accuracy of the model increases as the target chart increases. However this is
not a proportional relationship. We felt that 840 test inputs gave a sufficiently large target
chart size; in fact the test in the next section shows that the accuracy of the model is very

satisfactory.
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Figure 4.4 The magnitude of X, Y, and Z stimulus with different inputs R and G when B
18 kept constant for the order-5 polynomial model.
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Table 4.6 Performance of four different interpolation techniques applied for characterizing
the EPSON printer using the spectral RMS error metric and AFgy.

Spectral RMS
Method Mean (><1072) Max (><1072) Std. dev. (><1072)
order-5 polynomial 0.0327 0.210 0.0261
Trilinear 0.0723 0.258 0.0455
Sequential 0.0320 0.198 0.0274
Neural Network 0.4276 0.938 0.150
AEgy

Method Mean | Max | Std. dev.

order-5 polynomial | 2.18 9.96 1.51

Trilinear 4.23 | 11.26 2.17

Sequential 1.63 6.69 1.07

Neural Network 32.44 | 66.66 11.34

4.3.2 Model accuracy test

To test the transformation, similar to the test applied to test the EIZO CRT monitor (Section
4.2.2), a different set of 425 selected input colors was used (also called test chart which is
included in the attached CD). These test inputs were selected such that each stimulus was
drawn randomly from a uniform density. These random inputs may or may not be the same
as the training color in the target chart. The PDSs of the colors measured from the printed
test chart are compared to the estimated PDSs by using the spectral RMS error metric
(Equation 4.2) and the CIELAB CIE-94 AFEy, error metric (Equation 2.22).

Table 4.6 gives the resulting errors in terms of mean, max, and standard deviation of both
the RMS and AFEy, error metrics. Giorgianni et al. [1, pg.360] reported AFEy, = 1.8 for the
CMYK Xerox Docucolor 12 laser printer using the sequential interpolation method. This
result strengthens our confidence about the accuracy of the whole modeling process as we got
AFEy, = 1.63 for our sequential model. Clearly as one can see, the sequential interpolation
technique is the most accurate model as we expected. However, the biggest drawback of
sequential interpolation is in its slow speed. It is much slower than the second best model,
the order-5 polynomial model. The resulting error of the order-5 polynomial model remains
in the acceptable range. As a result of this test, we decided to choose the polynomial model

for our study.

The order of the polynomial also affects the accuracy of the model. Table 4.7 shows the

performance of the polynomial model when the order is 4, 5, and 6 based on the spectral
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Table 4.7 Performance of the polynomial technique with different order values based on the
spectral RMS error metric.

Spectral RMS

Polynomial order | Mean (><1072) Max (><1072) Std. dev. (><1072)
4 0.0416 0.159 0.0209
5 0.0327 0.210 0.0261
6 0.0459 1.272 0.0833

RMS error metric. We conclude that the polynomial order of 5 is the best model and will
be used in this study.

4.3.3 The effect of the colored-filter glass

Unlike the monitor, where the effect of the colored-filter glasses can be represented by a
simple 3x3 matrix, the CIE XYZ tristimulus values of the light reflecting from a paper and
going through an colored-filter glass S(\) can be estimated as follows: first estimate the re-
flecting light S(\) from the given input RGB tristimulus using the order-5 polynomial model
described in the previous section, and then multiply this spectrum with the filter absorp-
tion curve f(A), and finally calculate the CIE XYZ tristimulus values from this estimated

spectrum.

4.4 Summary

The CRT display and printer used in the study are the EIZO CRT monitor and the EPSON
Stylus Photo 2200 printer. Their SFCFs were implemented and tested. With the EIZO CRT
monitor, its SFCF is the model-based. We chose the GOG model as its gamma-correction
function. With the EPSON printer, its SFCF is based on the empirical method. As the
results of the accuracy test, we concluded that the order-5 polynomial gives the best result
in terms of the accuracy and execution time. The details of the implementations are given

in this chapter.



CHAPTER
FIVE

Development of an anaglyph algorithm for additive
displays

THE INTENTION OF THIS CHAPTER is to find an anaglyph method that renders anaglyph
images optimized for displaying on a CRT display with better 3D perception than previous
methods. During the research, many techniques have been tried but none of them has shown
a strong improvement over the LP method in terms of the color stability and color fidelity.
A simple experiment was set up to help us to conclude that it is unlikely that we can do
any better than the LP method in terms of color stability and color fidelity. So rather than
concentrating on improving the color fidelity, we focused on the ghosting effect which leads
us to a new method for reducing the ghosting effect. This method can be seen as a post-
processing on a given anaglyph method. In this chapter, all the algorithms were tested with
the EIZO CRT monitor whose Yspcr, crr(-) has been determined in Section 4.2, and the
colored-filter glasses are the red-cyan filters whose absorption curves are shown in Figure
2.5.

5.1 Search for a better anaglyph algorithm

In this section we describe anaglyph algorithms that are found to have good potential but

so far have not given us better results than the LP method.

5.1.1 Extension of the LP method in the color-appearance space

The LP method is considered to be the best method so far for creating anaglyph images
for display on CRT displays even though its drawback is in the ghosting effect. We have

o4
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seen that the LP method basically minimizes the color distances in CIE XYZ color space
between the left anaglyph perceived color [14.(), x)] and the original color [I; (), x)] and
between [I4r(A, x)] and [Ig(A,x)]. Now, one possibility for modifying the method is that
the optimization can be carried in a color-appearance space. We chose the CIELAB color
space. In order to do this, we first convert the CIE XYZ tristimulus values I xyz(x),
Inxvz(x), Lap xyz(x), and Iag xyz(x) into the CIELAB coordinates I, 1.(x), I Lab(X),
Iar rap(x), and Iapg rap(x) using Equation 2.21 with the CRT display white point as the

reference white. We then search for the anaglyph image input I4 rop(x) such that

IA,RGB,Opt (X) = arg IAqf}?Gi;l(x) {AE94 (IL,Lab(X), IAL,Lab(X)) + Ay, (IR,Lab(X), IAR,Lab(X))} .

(5.1)
The optimal solution I4 pep(x) can be found by using a nonlinear optimization method.
From Section 6.3, the MATLAB function fminimaz in the “Optimization Toolbox” is used.
We don’t restrict the range of the solution in fminimaz. The starting point for the fminimax
function is set to the result from the LP method. At the end, the white-point normalization,
that is similar to the one used in the LP method, needs to be performed to bring the solution
in the range of [0, 1|. This means we first find an input E = I4 gep(x) for I rep(x) = [1,
1, 1] and Ig rep(x) = [1, 1, 1], then

1/En 0 0
14 rGB Norm(X) = 0 1/Eq 0 14 rap(x). (5.2)
0 0 1/Eg

The rendered anaglyph images of the three test stereo image pairs using this method were
poor as they show very strong ghosting effect and the colors are getting more saturated

which leads to the loss of the details of the original images.

5.1.2 Luminance matching algorithm

As mentioned in Section 3.1.2, the luminances of the left and right perceived colors play
an important role in determining the quality of the dichoptic color mixture. By controlling
the luminance of the left and right views we can hopefully improve the quality of the 3D
perception. This is the idea behind the Luminance Matching (LuM) method proposed here.
In the LuM method, the first two degrees of freedom in I4 rep(x) can be used to control the
luminance [ 47, xyzy(x) and the luminance I 4 xyzy(x). The remaining degree of freedom
in I4 rep(x) can be used to match the chromaticities of [147 (), x)] and [I4r(), x)]. Basically,

we want IAL,XYZ,Y(X) = DL(X) and IAR,XYZ,Y(X) = DR(X), where DL(X) and DR(X) are
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the desired luminances. From Equation 3.21 we have

Dp(x) = apo-Taresr(X)+arse - Iaresc(X)+apss - Laress(X), (5.3)

Dr(x) = aro-Iareer(X)+arae - Laresc(X)+ aros - Laress(X), (5.4)

where [A];; = ar; and [Ag)i; = ag,; with i, j = 1, 2, 3. Section 4.2.3 gives the values of
the matrix A and Ag for the EIZO CRT monitor. From Equations 5.3 and 5.4, we obtain

Isrepr(X) = Ei1+ Es-Iagesp(x), (5.5)
Isrepc(x) = Es+ Ey-Iagess(x), (5.6)

where Ey, Ey, E3, and E, are constants and that can be precomputed based on Dy (x), Dg(x),
ar,ij, and ag;j. Thus the only thing left to find is [ 4 pep,5(x). We want to use this last degree
of freedom to match the chromaticities. Let (14, xyz2(X), Lar,xvzy(X)) and (L ag xy z.(X),
I AR xvzy(x)) be the xy chromaticity coordinates of T4z xyz(x), Iar xyz(X), respectively.
With Equations 5.5 and 5.6, we can easily prove that these xy chromaticity coordinates
are functions of one variable I4 gop p(x) with some constants and can be precomputed
from Dy (x), Dr(x), arj, and ag,j. Assume that (Dy .(x), Dp,(x)) are the desired xy
chromaticity coordinates for (/ar xvz.(X), Larxvzy(x)) and (Dg.(x), Dry(x)) are the
desired xy chromaticity coordinates for (/ ar xy z.4(X), Lar xyzy(x)). We want to determine

I A,raB,B(X) using

IareB,Bopt(x) =arg  min  {Ojbpyu}
I4,rGB,B(X)

OijuM = (]AL,XYZ,x(X) - DL,:E(X))2 + (IAL,XYZ,y(X) - DL,y(X))2

(5.7)
+(Iar,xyz2(X) = Dpa(x))* + (Lap.xyzy(X) — Dry(x))?
The objective function 5.7 can be expressed as
. _ Es+Es-1a,raB,B(X) 2 E9+F10-14,reB,B(X) 2
Ojbrum = <E7+E8-IA,RGB,B(X) N DL’I(X)> T <E7+E8~1A,RGB,B(X) N DL’y(X)> (5.8)

+ <E13+E14-1A’RG313(X) i DRJ: (X)>2 + <E15+E16'1A,RGB,B(X) . DRvy(X)>2 7

E11+E12-14 raB,B(X) E11+E12-14 reB,B(X)

where all the constants E; with ¢ = 5, ..., 12 can be precomputed directly from Dy (x),
Dg(x), ar,i;, and ag;;. The latter objective function includes only one variable 4 pap,5(X)
and hence it can be minimized by taking the derivative with respect to I4 rep p(x) and
setting it to 0 to solve for I4 pep p(x). Alternatively, we can use a nonlinear optimization

method to solve for 14 pep p(x). Then the desired 4 rep r(X) and 14 gepc(x) can be
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calculated from Equations 5.5 and 5.6. If the resulting I4 pep(x) is not in the range |0,
1] then we can perform the white-point normalization similar to the one used in the LP
method.

The desired values of Dy (x) and Dg(x) should be functions of the luminances of the original
left and right perspective images respectively. The values of (Dy, ,(x), Dy, ,(x)) and (Dg (%),
Dpg,(x)) should be functions of the xy chromaticity coordinates of I, xyz(x) and I xyz(x)
respectively. We have tested the method with different values of those desired parameter.
One trivial selection was D (x) = I xyzy(X), Dr(X) = Ir xyzy(X), Dp.(x) = I xyz.(X),
Dy (x) = I xyzy(X), Dro(X) = Ip xyz.(X), and Dg,(x) = Ir xyz,(X). So far, we have
not succeeded in finding a set of parameters that can render anaglyph images which give
better quality than those of the LP method.

5.2 Anaglyph dichoptic color mixture experiment

Many trials were performed to find a better anaglyph algorithm but none have succeeded to
give noticeably better results than the LP method in terms of the color stability and color
fidelity. We have also noticed that with the red-cyan filters, if we look at a color through
these glasses then the perceived dichoptic color mixture (Section 3.1.2) is very close to the
color that the right eye perceives through the cyan filter. One example is that the colors we
perceive when we view the colors in the target chart and the test chart through the red-cyan
filters are close to the perceived colors when we view them through the cyan filter only. This
suggests it is likely that the gamut of the perceived dichoptic color mixture is not much

larger than, and overlaps with, the gamut of the cyan filter.

To further confirm the above observation we set up a simple experiment. In this experiment,
two same-size squares of the same color are displayed side by side on the EIZO CRT monitor
on a gray background (since people often assume a gray-world assumption) in a dark room.
The observer, with the left eye wearing the red filter and right eye wearing the cyan filter,
looks at these two squares through a device called “Stereoopticon 707” [27]. This device
allows each eye to see only one square. The position of this device is adjusted such that
the right eye will see two areas: one area has the color that is the perceived dichoptic color
mixture and the other area has the color that is perceived by the right eye as it sees the
color while the left eye is closed. This step allows us to check the similarity between the
perceived dichoptic color mixture and the right perceived color. In the next step, the position
of “Stereoopticon 707 is readjusted such that the left eye will see two areas: again one is

the perceived dichoptic color mixture and the other one is the left perceived color. This step
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allows us to check the similarity between the perceived dichoptic color mixture and the left
perceived color. In the experiment, each of the colors in the test chart is displayed in those
two squares. The experiment was repeated for a yellow-blue filter pair whose absorption

curves shown in Figure 3.3.

Through the experiment, with the red-cyan filter, we saw that most of the perceived di-
choptic color mixtures are close to the right perceived colors. With the yellow-blue filters,
we observed that most of the perceived dichoptic color mixtures are close to either the left
or the right perceived colors. From this experiment we also noticed that when the left and
right perceived colors have very different chromaticities, then if the luminances of these two
colors are high and equal, a strong rivalry occurs. If one of those two colors has higher lumi-
nance then dichoptic color mixture is close to that one. In the case of rivalry, the perceived
dichoptic color mixture becomes more stable as the sizes of those two squares get smaller.
This observation may explain why the dichoptic color mixtures are close to either the left or
the right perceived colors. Please note that these observations in this experiment were made

only by the author of the thesis.

With these results, we may conclude that it is unlikely to have an anaglyph image that gives
the 3D perception with colors the same as the original scene. Moreover, we have concluded
that the anaglyph images rendered by the LP method give good color fidelity and color
stability. Also through observation, the dichoptic color mixtures of these anaglyph images
pretty much spans the gamut of the cyan filter. Therefore, it is likely that we cannot find
anaglyph images that have better color fidelity and color stability than the anaglyph images
rendered by the LP method!. Because of this, we shifted our focus to reducing the ghosting
effect that occurs with the LP method. This leads us to redefine the ghosting effect, as

discussed in the following section.

5.3 A new way of defining the anaglyph ghosting effect

The way of defining the quantity called “ghosting effect” shown in Section 3.5 is rather
simple and mainly used for testing whether a pair of colored-filter glasses and the color
display device are good for viewing anaglyph images overall. It, however, doesn’t allow us to
define or measure the ghosting level of a particular anaglyph algorithm at a particular pixel.
One good example to demonstrate this is that the interesting region REDCARS3 rendered
by the Photoshop method gives much less ghosting effect then that rendered from the LP

method, even though, based on the overall effect, the one from the LP method is much

IThis conclusion represents the opinion of the author of this thesis
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more comfortable to view. Therefore, in this section we propose a new way of establishing a
mathematical formula to calculate the ghosting level at a particular pixel for a given anaglyph

algorithm.
5.3.1 New anaglyph ghosting effect formulation

The colors [1a7(A,x)] and [I4r(\,x)] are the colors perceived by the left and right eyes,
respectively, when the anaglyph input I4 gep(x) is displayed and viewed with a pair of
glasses. From Equations 3.2, 3.4, 3.5, and 3.6, the left and right perceived colors [I41 (), x)]

and [I4r(A, x)] can be derived as

[Tar(N, x)] = [Tsrer(Yana(Iz ren(X), Ir rap(x))) - fL(N)],

(5.9)
Tar(A\, x)] = [Ysrer (T anaIo,res (%), I rcn(X))) - fR(N)],

where Ygpop(+) is the color display device’s SFCF. We have seen that, the color [I41 (A, x)]
cannot be the same as [I1(\,x)]. Therefore, it can be considered as a combination of two
colors in which one of them is contributed by Iy rep(x), and the other one is contributed by

Ir rep(x). Thus [I41(A,x)] can be redefined as

Har(Ax)] = [Tsrcr (Tanar (Iz.res(X))) - fL(N)]

(5.10)
+ [Ysror (T ana,chost Ir.rep(X))) - fL(N)],

where Y apar(+) is the function to convert Iy, rop(x) into the information which is received by
the left eye (this information can be seen as the intended image for left eye) and Y ana,chostr. (*)
is the function to define the leaking information of I rep(x) into the left eye (this informa-
tion can be seen as the ghosting information for the left eye). With the same argument, the

right perceived color [I4r(), x)] can be redefined as

Tar(\,x)] = [Ysrer(Tanar(Irren(X))) - frR(N)]

(5.11)
+[Ysrer (T Ana,Ghostr (I1.raB(X))) - fr(N)],

where Y pnar(+) is the function to convert Ig pep(x) into the information which is received by
the right eye, and Y ana,chostr (+) is the function to define the leaking information of I, rap(x)

into the right eye. To simplify notation, lets define

IoareB(X) = Tanar(In rep(X)), (5.12)

Ira ree(X) = Tanar(Ir rep(X)).
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1.4 rep is referred to as the left anaglyph intended image, and I1ra rap is referred to as the
right anaglyph intended image. We now need to find the two functions Y apar(+) and YT ppar(-)-
We can denote the CIE XYZ tristimulus values of the colors [Yspcr(Ina ras(x))-fL(N)],

[Ysrer(Inaras(X)):-frRON)], [Ysrer (Irares(X))-fo(N)], and [Ysper (Ira ras(X))- fr(N)] as

ILAL,XYZ,Y(X) [LAL,XYZ,Z(X> ]7
) (%) ]
) (x)

IRAR,XYZ,X(X) IRAR,XYZ,Y(X) IRAR,XYZ,Z(X) ]

Ioap xvz(x Inanxyzx(x

X

Inarxyz(x Itarxvyzz2

(5.13)

)
) :
) IRAL,XYZ,Y (X IRAL,XYZ,Z X) s

= [ )

= [ ILAR,XYZ,X(X) ILAR,XYZ,Y(X
= [ IRAL,XYZ,X(X)

=

(
IRAL,XYZ(X
(

IRAR,XYZ X)

In order to have a good 3D perception, the color I xyz(x) must be close to [z (), x)]
and must contain no information of Ig rep(x). In order words, we must absolutely see
I.4L xvz(x) without any ghosting effect when viewing under the red filter, and this leads to

one possible definition for I 4 pep(x) as

IoareB(X) = YTanar (I res(X)) = YTana (In.rep(Xx),0), (5.14)

where 0 is the zero vector [0 0 0]. This is equivalent to replacing the right original image
in the stereo image pair by a same-size black image in the original anaglyph algorithm.
Obviously, I54 rep(x) doesn’t contain any information of I pep(x) in the equation. In
fact, it has been seen from the LP and Photoshop methods that according to this definition

the color I 4 xyz(x) looks very similar to [[4r (A, x)]. Similarly, Ira rep is defined as

Iraree(X) = Tanar Irres(X)) = Tana (0,1r rep(X)) . (5.15)

This is equivalent to replacing the left image in the stereo image pair by a same-size black

image in the original anaglyph algorithm.

Similar to the idea in [18], one possible way of defining the level of ghosting in one eye
can be defined as the percentage of the ratio of area under the PDS curve of the ab-
solute difference between PDS I4,(\, x) and the PDS Ysperp(Ia rep(x))-fo(A), and the
PDS Ysrer(Ina,ran(X)) fL(N),

)\maz

[ wN) [ Lar(X, x) = Ysper (Tnaras(x)) - fo(A)]dA
Top(x) = 2min x 100%, (5.16)

)\maz

[ w(N) | Tseer (Iparas(X)) - fo(A)]dX

>\min
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where w(\) is a weight function. A similar expression holds for defining the ghosting level
in the right eye. However, test results revealed that these equations are not good measures

of the ghosting level. Therefore, we need to find different formulae.

Consequently, we defined the ghosting level for the left eye at a point x as the color dis-
tance between the real color perceived by the left eye I4., xyz(x) and the left intended color
I,40 xyz(x). Similarly the ghosting level for the right eye at a point x is the color dis-
tance between the color perceived by the right eye I4r xyz(x) and the right intended color
Irar xvz(x). The color distance metric can be the CIE XYZ Euclidean distance or AEj,.
We chose CIELAB CIE-94 (Equation 2.22) as it is a more uniform color space. Therefore, the
ghosting level indications for the left eye can be calculated by first converting the CIE XYZ
tristimulus values Ipar xyz(x) and Iap xyz(x) into the CIELAB coordinates Ipar rqb(x)
and Iz r.p(x) with the CRT white point as the reference white and then applying the color

distance metric

Ior(x) = AEou([Irar,cas( N X)), Lar,Lap(A, X)]) - (5.17)

A similar expression holds for the right ghosting level indication Igg(x). One interesting
point is that if the left perceived color 14y xyz(x) is darker than the left intended color
I.4L xvz(x) then we experience the so-called dark ghosting effect. And if the left perceived
color is lighter than the left intended color then we have the light ghosting effect. The section

below shows an example for this definition.

5.3.2 Example of applying the new ghosting calculation for a CRT
display

For CRT displays, we replace YTspcr(-) by Ysrer.crr(-). Here, we used the EIZO CRT

monitor’s SFCF established in Section 4.2. Therefore, under the LP method, from Equation

3.26, the left and right anaglyph intended images Iy rgp and Ira rgp can be found as

T T -1 | IL,RGB(X)T
Iaree(x)" =N-(R"-R)" -R-Ay- , (5.18)

o
Ipares(x)” =N-(R"-R)™"-R-A; - . ] . (5.19)
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Table 5.1 The ghosting levels at four different points in the REDCAR stereo image pair and
two different points in the ICIP stereo image pair for the red-cyan filters and the EIZO CRT
monitor for the Photoshop and LP algorithms using the new definition.

X1 X2 X3
Algorithms | Left | Right Left | Right | Left | Right
Photoshop 1.304 | 7.628 | 13.238 | 0.143 | 0.066 | 3.066
LP 0.385 | 11.719 | 9.206 | 0.474 | 0.378 | 2.330
X4 X5 X6
Left | Right Left | Right | Left | Right
Photoshop 1.555 | 0.688 | 0.464 | 4.333 | 37.405 0
LP 0.552 | 1.645 | 0.106 | 10.06 | 35.246 | 0.025

For the Photoshop method, from Equation 3.12, Iy 4 pep(x) and Iga rep(x) can be found

as
1000 0
1 x)T
Ianrcs(x)"=10000 10 [ L’RGg‘() ] (5.20)
000001
100000 0
Iparee(x)"=10 000 10 '[1 ()T]. (5.21)
00000 1 RAGBLX

In order to demonstrate the new ghosting effect formula, we pick four different points in the
REDCAR stereo image pair, which are x;(443, 343) (this point is in the flower in the left
image and it exhibits a strong ghosting for the right eye under the LP method), x5(440, 318)
(this point is in the flower of right image and it exhibits a ghosting for the left eye), x35(295,
275) (this point is at the red car), x4(110, 149) (this point is at the green leaf), and two
different points in the ICIP stereo image pair, which are x5(305, 355) (this point exhibits a
strong ghosting for the right eye) and x4(862, 666) (this point exhibits a strong ghosting for
the left eye). Table 5.1 summarizes the resulting ghosting levels using the Photoshop and
LP methods at these chosen points for the red-cyan filter pair and the EIZO CRT monitor

using the new definition.

As we see from the table, at the points x; and x5 (these two points are the right occluded
points), they show a much stronger ghosting effect on right eye if compared to that on the
left eye for both the Photoshop and LP algorithms. This complies with what we observed
from the rendered REDCAR anaglyph images. However, at the points x5 and xg (these two
points are the left occluded points), they show a much stronger ghosting effect on the left
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! L,RGB (x) Base ILA,RGB (X)‘ %
Anaglyph | x) Ghosting IA, RGB )
'RrReB ) | Algorithm | _RARGB ™| Reduction
(eg.LP)

Figure 5.1 The ghosting reduction component is used after the anaglyph algorithm to reduce
the ghosting level without sacrificing the color stability and fidelity.

eye if compared to that on the right eye for both the Photoshop and LP methods. This
again complies with what we observed from the rendered anaglyph images. Between the
Photoshop and LP methods, the right eye ghosting effect is stronger for the LP method at
x; and x5 and the left eye ghosting effect is stronger for the Photoshop method at x; and xg.
However the right ghosting effect seems to suppress the left ghosting effect in the case of the
red-cyan filters to give us the perception of overall strong ghosting effect on the LP method.
This can be explained due to characteristic of the dichoptic color mixture phenomenon of
the red-cyan filters (Section 5.2). At the points x5 and x4 (these two points are not the
occluded points), they show weak ghosting effects on both the left and right eyes. These
results comply with the fact that the ghosting effect is most visible near the border of the

scene objects.

5.4 Reduction of the ghosting component

Through both human judgment and the results of Table 5.1, we conclude that the ghosting
level in the REDCAR anaglyph image rendered by the LP method is higher than that in the
REDCAR anaglyph image rendered by the Photoshop method. However, the LP method
gives better overall comfort in terms of the color fidelity and color stability. Thus, rather
than finding a new anaglyph algorithm that can satisfy all three conditions, we can try
to reduce the ghosting level in the anaglyph images rendered by the LP method without
sacrificing much of its comfort and color fidelity. This idea leads us to a way of decomposing
the anaglyph algorithm into two components: anaglyph rendering component and ghosting
reduction component as illustrated in the Figure 5.1. Based on the new definition of the
ghosting effect, we propose a way of reducing the ghosting level known as the left-right
matching (LRM) ghosting reduction algorithm.
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5.4.1 LRM ghosting reduction method for a CRT

In the LRM ghosting reduction method, for a given anaglyph algorithm, e.g. the Photoshop
method or the LP method, the left and right anaglyph intended images I 4 rep and Ira ras
can be found by using Equations 5.14 and 5.15. The idea of the LRM ghosting reduction
method is that we want to find the ghosting reduced anaglyph input I* 4 rgp(x) such that
its left and right perceived colors I* 41 xyz(x) and I*4gr xyz(x) are as close as possible
to Ipar xvz(x) and Igag xyz(x), respectively. In other words, we want to minimize the
ghosting levels. We have developed two different ways to do this: LRM-1 and LRM-2.

5.4.1.1 LRM-1 ghosting reduction method

The objective above naturally leads us to think of finding the optimal solution I*4 rep(X)

to minimize the following objective function

I" 4 rGB,0pt(X) = arg  min ){OijRM-l}

I* 4 raB(X
OjbLrm1 = wn ([LAL,XYZ,X(X) - [*AL,XYZ,X (X) 2 + wo ([LAL,XYZ,Y(X)
_I*AL,XYZ,Y(X))Q + w3 (ILAL,XYZ,Z(X) - I*AL,XYZ,Z(X))2 (5 22)
+ws (Irar xvzx(X) — I*ar xvz.x(X) s ws (Irar xvzy(X)
—[*AR,XYZ,Y(X))2 + we (Ipar.xy z,2(x) — I*AR,XYZ,Z(X))2 ;
where w; with i = 1, 2, ..., 6 are weights and
ILAL,XYZ(X)T =Ap- ILA,RGB(X)T7 (5 23)
IRAR,XYZ(X)T =Ap- IRA,RGB (X)T-
Equation 3.22 can be applied for I* 4 gop(x) as
I*A X T A
i} vz )T = " T ares(®)T =R-T 4 pap(x)7,
I AR,XYZ(X) Ag (5 24)

A
R=|""].
Agr
This is the same as finding the minimum sum of the two color distances between I* 41, xyz(x)
and ILAL,XYZ(X> and between I*AR7Xyz(X) and IRAR,XYZ(X> in the CIE XYZ color Space. To
find the solution for this optimization problem, one way is that we take the partial derivative

of the function Objrrar—1 With respect to I*4 raB.r, 1" 4 rGB.G, and 1" 4 grep p and set these

partial derivatives to 0 and solve for I* 4 rap.r, I*a.rcB,G, and I 4 e p. A different way
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to solve this problem is to apply the well known projection method [24] as used in the LP
method (Section 3.6.3).

By rearranging Equation 5.23, we obtain

Lrarep(x)"
A, O

Ay=| " , 0= , (5.25)
0 Ap

Vi(x) = [ 1.4 reB(X) ] '

Ira ros(x)T

[ ILAL,XYZ(X)T ] [ ] [ Ip4 RGB X ] — A, Vl(x),
Trarxyz(x)" 0 Agr

0 0

0 0

0 0

o o O

From the projection method, the optimal vector I* 4 rep(x) can be obtained by projecting

the vector V(x) onto subspace S, giving
" s res(x)” = (RTWR) - RWA; - V,(x), (5.26)

where W is the 6x6 positive-definite diagonal weight matrix with the diagonal entries of

(w; Xwy).

The minimum sum of two color distances between I*4; xyz(x) and Ipaz xyz(x) and be-
tween I* 4g xyz(x) and Irag xyz(Xx) can also be carried in the CIELAB space with CIE-E94
as the color distance metric. Then a nonlinear optimization method can be used to find
I* 4 rep(x), with the anaglyph image rendered by the LP method as starting point. How-
ever, the CIELAB space is not much better than the CIE XYZ space for this purpose and

it is very slow.

5.4.1.2 LRM-2 ghosting reduction method

This method is based on the idea of predistorting the left and right anaglyph intended
images I;4 rep and Iga pep, and is similar to the idea used in [28]. As we pointed out
previously, the left perceived color 14 xyz(x) can be considered as a combination of two
parts: Ipar xyz(x) plus the ghosting contributed by Iz rep(x). Therefore, if somehow we
are able to predistort the color I 4z xyz(x) with an amount of the ghosting level contributed
by Ira rep(x), then by adding those left and right predistorted colors together, the ghosting

can be reduced.
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Notice that if by letting I* 4 rep(x) = ILa ree(X) + Igra rep(X), then the left eye perceives

Farxvz(x) = Ap-Ipares(x)T + AL - Irares(x)"

(5.27)
= Iparxvz(x)" + Ap - Ipares(x)’.

The source of the left ghosting thus can be seen as Aj-Irarep(x)?. Similarly, the source
of the right ghosting can be seen as AR-ILARGB(X)T. We then predistort the left perceived
color and the right perceived color as

Lo, xyzpistorted (X)T = AL - (Inares(X)" — Ira res(x)T), (5.28)

Irar xy zpistorted (X)T = Ag - Trares(X)" — Iparcn(x)T).

Next, we want to find I54 rep Distorted (X) such that its left perceived color must be close to
I 4L xv 2z Distorted (X) and its right perceived color must close to dark. This problem again is
similar to the optimization problem stated for LRM-1 with V;(x) replaced by V 14 pistorted (X),

where

ILA,RGB(X)T - IRA,RGB (X)T

VLA,Distorted (X) - 0 s (529)

and by applying the projection method, I 4 rep Distorted (X) can be found as
174 rGB.Distorted (X)T = (RTWLR)™ - RW A3 - V4 pistorted (X)), (5.30)

where W is the 6x6 positive-definite diagonal weight matrix. Similarly, we want to find
IrA RGB Distorted (X) that its right perceived color must be close to Ira xv z pistorted (X) and its

left perceived color must be close to dark and we obtain

0

Tra.reB.Distored (X)) = (RTWRR)™ - RWgRA; - ., (5.31)

Irares(X)T —Iparan(X)

where W, is the 6x6 positive-definite diagonal weight matrix. Finally, the anaglyph input
I* 4 rep(x) can be found by first clipping I 4 re B bistorted (X) and Ira raB Distorted (X) to be in

the range of [0, 1] and then adding them to get

I" 4 reB(X) = 1.4 RGB Distorted (X) + IrA RGB Distorted (X)- (5.32)

5.4.2 Test results and discussion

The LP method was chosen to be the base anaglyph algorithm for these two LRM methods
for EIZO CRT monitor and the red-cyan filters. Sections C.8 and C.9 contain the resulting
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Table 5.2 The ghosting levels at four different points in the REDCAR stereo image pair and
two different points in the ICIP stereo image pair for the red-cyan filters and the EIZO CRT
monitor for the LRM-1 and LRM-2 algorithms based on the LP method.

X1 X2 X3
Algorithms | Left | Right | Left | Right Left Right
LRM-1 1.373 | 3.688 | 7.982 | 0.085 | 0.314 | 0.537
LRM-2 1.506 | 4.899 | 8.403 | 0.031 | 0.438 | 0.622
X4 X5 Xg
Left | Right | Left | Right Left Right
LRM-1 0.513 | 0.345 | 0.043 | 3.621 | 35.318 | 0.650
LRM-2 0.658 | 0.686 | 0.261 | 5.383 | 35.262 | 0.129

anaglyph images from the three test stereo image pairs for the LRM-1 and LRM-2 methods
respectively for the EIZO CRT monitor and the red-cyan filters. Here, for LRM-1 the W
matrix is a 6 x6 identity matrix; for LRM-2 the W and Wy matrices are diagonal matrices
with diagonal entries of [10%, 10, 10%, 1, 1, 1] and [1, 1, 1, 10%, 10%, 10?] respectively. Similar
to Table 5.1, Table 5.2 shows the resulting ghosting levels under the LRM-1 and LRM-2
methods at those six points for the red-cyan filter pair and the EIZO CRT monitor.

First, all the anaglyph images rendered by those two LRM methods are better than their
LP versions in term of the ghosting effect. The ghosting effects in those anaglyph images
are significantly reduced without sacrificing the strengths of the LP method (e.g. clearly
demonstrated at the interesting region REDCARS3). The results from Table 5.2 also indicate
that there were significant reductions in the ghosting levels at those six points when compared
with the LP method. The three anaglyph images rendered by LRM-2 give better overall 3D
perception than the anaglyph images rendered by LRM-1. The anaglyph images rendered by
LRM-2 tend to exhibit a light ghosting effect. The quality of the rendered anaglyph images
from LRM1 and LRM-2 strongly depends on the values of their weight matrices. Ideally, for
each different stereo image pair, it is necessary to adjust the weight matrices to get the best

results.

The LRM ghosting reduction algorithms work well in general. However, there is one condition
that is required in order for the LRM methods to work well, that is the leaking color perceived
by the left eye Ipar xvz(x) (when seeing the right anaglyph intended image Iga rop(X))
must be darker than the left anaglyph intended color Iy 4 xyz(x), and similarly the leaking
color perceived by the right eye I 4r xyz(x) (when seeing the left anaglyph intended image
I.4.reB(x)), must be darker than the right anaglyph intended color Igag xyz(x). The
reason for the leaking PDSs I (A, x) = Ysrer, crr(Ina res(X))-fr(N) and Igar (A, x) =
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Figure 5.2 At the point x¢, LRM can’t reduce the ghosting level in the left eye. Because in
the lower figure, the PDS of the color Irar xyz(xe) (dotted line) is much stronger than the
useful PDS of the color Ipar, xyz(Xe) (solid line). In the upper figure, the useful PDS (solid
line) is dominated. In the upper figure, the leaking signal is not shown since it is very small.

Ysrcr, crr(Ira rep(X))- fL(A) to exist is that the independent condition for the device ® in
Section 3.2.1.1 doesn’t hold for the EIZO CRT monitor.

One example to demonstrate this condition is that from Tables 5.1 and 5.2, the left and right
ghosting levels from the LRM-1 and LRM-2 methods at the point x4 are the same as the left
and right ghosting levels from the LP method. This means the ghosting is not reduced at
this point. The upper and lower dotted lines in Figure 5.2 are the leaking PDSs I 4r(\, Xg)
and Irar (A, xg) respectively at xg and the upper and lower solid lines are the useful PDSs
ITrar(\, x¢) and Ipar (A, xg) respectively. We can see that the leaking PDS Irar (A, xg) is
much stronger than the useful PDS I 41 (\, x6). If we take a close look at the interesting
regions [CIP1 rendered by the LRM-1 and LP methods through the red filter only, we can
see that both of the regions exhibit a strong ghosting at the dark horizontal bars where are

not uniform dark but there are a darker areas.

5.5 Preprocessing module

From the above section for the case of the point xg, in order to further reduce the ghost-
ing level we can increase the useful PDS I 41 (), x¢) and/or to decrease the leaking PDS

Irar (A xg). In the other words, we have to lighten the color Iz xyz(Xs) and/or darken
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Figure 5.3 The Preprocessing component is used after the LP algorithm to further reduce
the ghosting effect.

the color Irar xvz(x¢). However, if we only lighten I 47 xyz(x) at the pixels that violate
the LRM condition (these points are usually at the boundaries of the objects in the stereo
image pairs) then we in fact create a ghosting effect on the left anaglyph intended image.
Similarly, if we only darken Igap xyz(x) at the violated pixels then we create a ghosting
effect on the right anaglyph intended image. As a result, these ghosting effects will slip
in the left or right anaglyph perceived color L4y xyz(x) or I4g xyz(x) through the LRM
ghosting reduction component. Therefore, to prevent this we need to modify not only those
violated points but also all the points in the objects which the violated points belong to. The
violation condition at the point xg is for the left eye, and similarly, the violation condition

can also happen in the right eye.

5.5.1 Luminance adjusted preprocessing module

To even further reduce the ghosting effect, we propose another process or Preprocessing
component as illustrated in Figure 5.3. The idea of the Preprocessing component is that
we want to increase the luminance of all the points in one anaglyph intended image and/or
decrease the luminance of the other anaglyph intended image. The choice of which anaglyph
intended image, whose luminance should be increased, depends on what pair of colored-filter
glasses are being used. From Section 5.2, we concluded that the final dichoptic color mixture
is similar to the color that is perceived by the eye with colored-filter glass that has the
larger independent band (Section 3.2.1.1). Also, one of the objectives of ghosting reduction
is not to sacrifice too much the color stability and color fidelity. Therefore, it should be a
good choice if we increase the luminance of the anaglyph intended image on the side with
the colored-filter glasses that has the smaller independent band. For example, with the
red-cyan filters we should choose to increase the luminance of the left anaglyph intended
image. Without loss of generality, assume that we want to increase the luminance of the left

anaglyph intended image I; 4 rep for the case of the red-cyan filters.

The Preprocessing step can be decomposed into three stages. In the first stage, we in-

crease the luminances of the dark colors and decrease the luminances of the bright colors
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Figure 5.4 The first stage of the Preprocessing module. Increase the luminance of dark colors
and decrease the luminance of light colors in the right anaglyph intended image.

in the right intended image Iga rep. First, convert the CIE XY7Z tristimulus values of the
color Irar xyz(x) into the CIELAB coordinates Ipar rab(X) = [{rAR,Lab,L(X) IRAR Laba(X)
IraR Labp(x)| with the reference white being the CRT display white seen through the right
filter (|Ysrcr, crr(|1, 1, 1])-fr(A)]) . Next, find the maximum luminance Irar Lab 1 Maz and
the minimum luminance Irar, Lab,z,vin @among those colors. Then I}, 14, 1 (X), which is the

luminance of the If, 5 1., (%), can be found from Irag,rabz(X) as

Ira X)— Ipa )
rarLan(X) = ((02 — ) x ( RAR,Lab,L(X) — IR R,Lab,L,Mm) +C1) (5.33)
IRAR,Lab,L,Max - IRAR,Lab,L,Min

X (IrAR, Lab,L,Maz — LRAR,Lab,L,Min) + IRAR,Lab,L, Min,

where ¢; and ¢, are two constants in the range of [0, 1| and ¢ > ¢;. Figure 5.4 graphs this lin-
ear relationship. Thus the CIELAB coordinates I 4p 144(X) are [Ijag 1oy 1(X) TRAR Laba(X)
Trar Labp(X)]. Convert Iy, p 1, (%) back to CIE XYZ tristimulus values Ip4p vy z(X) and
then to I, pep(X) (in the case of LRM-2).

Specifically, to convert Ig,p vy,(X) to Ty pop(Xx), we want to find the optimal input
T4 rep(%) such that sum of AFEyy; between the color which the right eye with filter sees
and I 4p xy 7 (X) and AExyz between the color which the left eye with filter sees and black.
The values of ¢; and ¢, control the appearance of the right intended color I, 45 vy (), thus
they control the appearance of the final 3D perception. If ¢;—= 0 and co—= 1 then this stage

is turned off.

The second stage includes the following steps: first convert the CIE XYZ tristimulus values of

the left anaglyph intended color I 47, xyz(x) and the right leaking color Igaz xyz(x) into the

CIELAB coordinates I5ar ra(X) = [IrAL Lab,2(X) IpAL Laba(X) LLAL Labp(X)] and Igar rap(X)
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Figure 5.5 Luminance adjusted conversion function for the second stage of the Preprocessing
module.

= |IrarL,Lab,r.(X) IRAL Laba(X) IRAL Labp(X)] Where the reference white point is the CRT white
seen through the left filter (|Yspcr, crr([1, 1, 1])-fL(N)]). Next find a point X,,., that has
maximum luminance difference (Ipar rap.r(X) - IpaL Lab,r(x)). If this maximum luminance
difference is negative then we stop the process. If this maximum luminance difference is

positive then calculate two values a and b as

IpAL, Lab,L(X) -1 IRAL,Lab,L(X)
> > 1 . AL, Lab, LA\
@ _ Lmaax Y Lmax ’ (5.34)
b 1 1 1

where L,,q, is the maximum luminance can be perceived by left eye through the red filter
and g is a scaler that is normally set to 1. Then the luminance I} 4; ;,, ;(X) can be expressed

from Ipar, pab,(X) as

;;AL,Lab,L(X) =a- ILAL,Lab,L(X) + b Log- (5.35)

Figure 5.5 illustrated the linear conversion function between I7 ,; 1., 1 (X) and Ipar ab,z(X)-
It can be easily seen that none of the adjusted luminances I7 4y 7 1 (X) can be larger than
the maximum luminance which can be produced by the CRT and hence we don’t need to

perform white-point normalization. However, the b value can be further changed by adjusting

qg.

The second stage increases the luminances of all the colors in left intended images. This
thus makes the bright colors in the left intended image even brighter. This in turn will cause
the ghosting effect in the right eye to increase. Thus we should decrease the luminances of

the bright colors in the left intended image without decreasing the luminances of the dark
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Figure 5.6 The third stage of the Preprocessing module. Increase the luminance of dark
colors and decrease the luminance of light colors in the left anaglyph intended image.

colors. In the last stage, the first step is to find the maximum luminance I} 47 1.5 1 rrar @a0d

. : , ,
the minimum luminance 17 47 7. 1 azin @MONG 17 47 14y 1 (X). Then calculate a and b as

—1
[ a ] <I’LAL,Lab,L(Xmax)_I/LAL,Lab,L,Mm) 1 <I/LAL,Lab,L(Xmax)_I/LAL,Lab,L,Mm)
o I I

!
LAL,Lab,L,Min

7 — 77 7 —
LAL,Lab,L,Maxz  *LAL,Lab,L,Min I an,Lab,,Maz™ T ,

1 1 C3
(5.36)
where ¢3 is a constant in the range of [0, 1] and X,,,4, is the point found in the second stage.

Then the luminance I7 45 ;. (X) can be calculated as

/ x) — I’ '
zAL7Lab’L(X) _ (CLX ( LAL,Lab,L( ) LAL,Lab,L,Mzn) —f-b) (537)

I — I
LAL,Lab,L,Max LAL,Lab,L,Min

X( ,LAL,Lab,L,Ma:v - 2AL,Lab,L,Min) + IiAL,Lab,L,Min'
Thus the final CIELAB coordinates I} 4, ;,,(x) are [IEAL,Lab,L(X) Ipar paba(X) ILAL Labp(X)]-
Convert I7 4/, 1,,(%) back to CIE XYZ tristimulus values I7 4/, vy, (x) and then to I} 4 zop(X)
(in the case of LRM-2).

Specifically, to convert I} 47 vy (X) to I7 4 pop(X), we want to find the optimal input I} 4 rop(X)
such that sum of AFEyy 7 between the color which the left eye with filter sees and I} 47 vy ()
and A FExy 7z between the color which the right eye with filter sees and black. Figure 5.6 graphs
the linear relationship between I} 4y ;4 1(X) and I} 47 14 (%). Clearly from the graph, c;
should not less than p. As c3 get smaller, the left intended image is blurrier. Set ¢35 to 1 if

we want to turn off the effect of this stage.



55 PREPROCESSING MODULE 73

Table 5.8 The ghosting levels at four different points in the REDCAR stereo image pair
and two different points in the ICIP stereo image pair for the red-cyan filters and the EIZ0O
CRT monitor for the Preprocessing algorithm prior to the LRM-1 algorithm based on the LP

method.
X1 X2 X3
Algorithms Left | Right | Left | Right Left | Right
Preprocessing prior to LRM-1 | 1.415 | 3.427 | 2.34 | 0.135 | 0.031 | 6.93
X4 X5 X6
Left | Right | Left | Right Left | Right
Preprocessing prior to LRM-1 | 0.099 | 5.114 | 0.041 | 3.671 | 11.697 | 0.021

5.5.2 Test results

To test the proposed Preprocessing algorithm, we used the LP method for base anaglyph
component and both LMR-1 and LMR-2 for ghosting reduction component with weight
matrices W, W, and Wy set to the suggested values. Section C.10 contains the rendered
anaglyph images from the three test stereo image pairs with ¢ = 1, ¢;—= 0, co = 1, and c3
= 0.8, for the EIZO CRT monitor and the red-cyan filters. The resulting anaglyph images
are comfortable to view with stable 3D perception and very little ghosting effect. However,
there is a bit less comfort to view these anaglyph images than to view those rendered by
LRM-1 or LRM-2 alone due to the decreasing in color stability. The increasing of the g value
will cause this discomfort to increase as well. If we look at the interesting region ICIP1, we
notice that the ghosting effect is reduced a lot if compared with LRM-1 or LRM-2. This,
therefore, provides a tradeoff between the color stability and the ghosting effect.

Similar to Table 5.2, Table 5.3 shows the resulting ghosting levels with the Preprocessing
algorithm prior to the LRM-1 method based on the LP method at those six points for the
red-cyan filter pair and the EIZO CRT monitor. From Section 5.3.1, the left ghosting level
for the Preprocessing algorithm is defined as the color distance AEg, between I} 47 vy ,(X)
and T, yy,(x). Similarly, the right ghosting level is defined as the color distance AFEg,
between I} vy 7(X) and Typ xy,(x). We can see that in general the left ghosting levels at
those six points are reduced (this complies with the fact that we observed the ghosting level
reduction in the REDCAR anaglyph image), whereas, the right ghosting levels are increased
only at the non-occluded points (points x3 and x4). This however does not increase the

overall right ghosting effect but decreases the color stability.
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5.5.3 Observations on other additive display devices

The process of modeling CRT displays is a time-consuming process. However, we have
observed that the rendered anaglyph images based on the EIZO CRT monitor’s SFCF still
gave very satisfactory results when displayed on different CRT monitors, e.g., the ghosting
effect is very low while the color stability and fidelity are kept high. Therefore, we can reuse
the EIZO CRT monitor’s SFCF and gamma-correction model to render anaglyph images for
different CRT monitor devices. Similarly, we have also used the rendered anaglyph images
for the EIZO CRT monitor to project onto a screen using the Electrohome EPS1024 SUPER
PolySi LCD projector and again the overall 3D perception of these anaglyph images was
very satisfactory. For LCD display devices, the rendered anaglyph images using the EIZO
CRT monitor’s SFCF gave good color stability and fidelity, but the ghosting effect in these
anaglyph images was a bit stronger than that of the rendered anaglyph images using the
LCD device’s SFCF. However, if one refers not to model LCD devices, then a CRT monitor’s
SFCF can be used to give good overal 3D perception.

5.6 Summary

The chapter started with discussions of two new algorithms: one is the extension of the LP
method in CIELAB color space, and the other one is LuM that first tries to exactly match
the luminances of the left and right perceived colors with desired luminances, and then uses
the last degree of freedom to match the chromaticities of the left and right perceived colors
with desired chromaticities. However, these two algorithms are not considered to be better
than the LP method. Through a simple experiment, it is likely that we cannot have an
anaglyph image that has better color fidelity and color stability then the anaglyph rendered
by the LP method. Thus we tried to minimize the ghosting effect in the LP method. This led
us to a new way of defining the ghosting level. This novel definition allows us to calculate the
ghosting levels of a particular anaglyph algorithm at a specific pixel. Based on this definition,
we proposed two extra processes, an LRM ghosting reduction component and a Preprocessing
component (Figure 5.3), to reduce the ghosting effect in the LP method without sacrificing
the strengths of the LP method. We have shown that the rendered anaglyph images have
very little ghosting effects.

Our recommendation for rendering an anaglyph image that is best displayed on a CRT
display from a given stereo image pair is as follows: first use the LP method to render the
anaglyph image. If the resulting anaglyph image is satisfactory then there is no need for

further processing. If the resulting image has strong ghosting, then apply the LRM-2 method
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after the LP method. If further ghosting reduction is desired then the Preprocessing method
can be involved prior to LRM-2.



CHAPTER
SIX

Development of anaglyph algorithm for printers

SO FAR NO LITERATURE has been found for anaglyph algorithms that are used to render
anaglyph images which are optimized for a particular printer. The intention of this chapter
is to find an anaglyph method that renders anaglyph images to be best printed on ordinary
paper. To test the developed anaglyph algorithm, the EPSON printer, whose Yspcr printer(-)
has been obtained in Section 4.3, is used to print the rendered anaglyph images, and the
colored-filter glasses are the red-cyan filters whose absorption curves are shown in Figure
2.5.

6.1 Strong ghosting effect problem in printer

As mentioned in Chapter 1, the biggest advantage of the anaglyph technique is that it is the
only way to allow us to perceive 3D effects with ordinary paper. In the prior technique for
perceiving 3D effect on paper, we print an anaglyph image that is rendered for CRT displays.
For example with the EPSON printer, we follow Section 4.3.1.1 to print an anaglyph image
that is optimized for the EIZO CRT monitor. However, due to the gamut mismatch between
the EIZO CRT monitor and the EPSON printer, the perceived image from the printed
version is not same as the perceived image from the monitor. The closeness between the
printed image and the monitor displayed image depends on the gamut mapping algorithm,
the printer’s profile, and the monitor’s profile (Section 2.2.4) which are involved during the

printing process.

Even in the case that these two images look the same, there is no guarantee that the left and

the right eye perceived images through the two colored-filter glasses of a monitor displayed
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Figure 6.1 The PDSs produced by the EPSON printer when the inputs are (0, 0.3, 0), (0,
0.6, 0), and (0, 1, 0).

image are the same as those of the printed image. With the EPSON printer and the red-
cyan filters, we can expect a stronger ghosting effect in the final fused 3D perception for
EPSON than EIZO. The main reason is that the EPSON printer cannot adjust the PDS
I4 5, (N, x) independently with the PDS 14 5, (), x) and vice versa (Section 3.2.1.1) and this
dependency between 45, (A, x) and I4 g, (A, x) is much stronger for the EPSON printer
than for the EIZO CRT monitor. For example, Figure 6.1 shows the reflected PDSs when
the inputs to the EPSON printer are (0, 0.3, 0), (0, 0.6, 0), and (0, 1, 0). We can see that
those PDSs are expanded in both the band B, of the red filter and the band By of the cyan
filter. If the green component in the input increases then both I, 5, (A, x) and I4 g, (A, x)
also increase. Therefore, it is impossible for the EPSON printer to produce the green-like

color on the right eye and dark color on the left eye.

This problem can be illustrated in Figure D.1 which is the EPSON printed version of the
REDCAR anaglyph image rendered by the LP-Preprocessing-LRM-1 method for the EIZO
CRT monitor and the red-cyan filters. In this figure, the interesting region REDCARS shows
a stronger ghosting effect than that of the EIZO CRT monitor displayed image. In general,
we have observed that a ghosting effect will be stronger in the printed versions. Therefore,
anaglyph images to be best displayed on paper cannot be rendered directly from anaglyph
algorithms specified for CRT displays.
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6.2 Test for compatibility between colored-filter glasses

and color output devices

It would be useful if we were able to capture the dependency between 4 g, (), x) and
I4 5, (A x). Here, we suggest a simple test to check this. A typical challenge in an anaglyph
algorithm would be to find an anaglyph input such that the perceived color in one eye with
the filter is bright and the perceived color in the other eye with the filter is dark. Often as
we increase the luminance of one perceived color then the luminance of the other perceived
color is also increased as well due to the dependency. Therefore, at a point x for instance,
if we want to have a desired luminance in the left perceived color then the luminance of
right perceived color cannot be lower than a certain minimum luminance. If the desired
luminance of the right perceived color is less than that of the minimum luminance then we
simply cannot find an anaglyph input to satisfy this requirement and hence the ghosting

effect will appear at that point.

To test the effect of 14 5,(\,x) on I4 5, (A, x), we want to find a digital input such that it
gives minimum luminance of the left eye perceived color while keeping the luminance of the
right eye perceived color to be greater than a fixed given luminance. We repeat that step for
several different fixed given luminances. For example, we can pick these fixed luminances to
be 50%, 60%, 70%, 80%, 85%, 90%, and 94% of the maximum luminance that the right eye
can perceive through the cyan filter. Finally, we convert those minimum luminances into
the percentage ratios with respect to the maximum luminance that the left eye can perceive.
The higher the percentage, the larger is the effect of 14 5, (\,x) on 14 5, (A, x). Similar steps

can be performed to see the effect of I4 5, (A, x) on 14 5, (\, x).

Table 6.1 shows the minimum resulting percentages for the red-cyan filters on the EIZO CRT
monitor and the EPSON printer. The first column is the fixed desired percentage luminances
with respect to the maximum luminance. The second column contains minimum luminance
percentages with respect to the maximum luminance that the left eye can perceive while
the luminance perceived by the right eye is kept fixed (testing the effect of 14 5,()\, %) on
T4, (N x)) for the EIZO CRT monitor. One example is that in the third row, to have the
luminance perceived by the right eye greater than 90% of the maximum luminance, then the
luminance perceived by the left eye cannot be less than 18.64% of the maximum luminance.
The third column contains minimum luminance percentages with respect to the maximum
luminance that the right eye can perceive while the luminance perceived by the left eye
is kept fixed (testing the effect of 145, (A, x) on I4z,(A, x)) for the EIZO CRT monitor.

The meaning of the fourth and fifth columns are similar to those of the second and third
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Table 6.1 The minimum percentage luminances with respect to the marimum luminance.

EIZO Monitor EPSON Printer

Fixed Luminance Left Eye Right Eye Left Eye Right Eye

percentage (Red Filter) (Cyan Filter) (Red Filter) (Cyan Filter)
94% 19.48% 71.03% 89.31% 69.85%
90% 18.64% 51.67% 81.13% 52.24%
85% 17.60% 27.53% 67.43% 22.54%
80% 16.56% 5.24% 37.73% 8.34%
70% 14.48% 4.60% 28.24% 4.00%
60% 12.42% 3.94% 21.24% 2.15%
50% 10.35% 3.28% 17.37% 1.45%

columns, respectively, for the EPSON printer. As we can see with the red filter, the effect
of I4p,(A,x) on I4p, (A x) is much stronger for the EPSON printer than that of the EIZO
CRT monitor. This explains why we experience a stronger ghosting on the left eye with the
EPSON printer than the EIZO CRT monitor. With the cyan filter, both the EPSON printer
and the EIZO CRT monitor give approximately the same effect of I4 g, (A, x) on I4 g, (A, X).
There is a big drop on the minimum percentage when the fixed desired luminance is dropped
from 85% to 80% (from 27.53% down to 5.24% for the EIZO CRT monitor and from 22.54%
down to 8.34% for the EPSON printer). Through this test, we can predict that the anaglyph
stereoscopic system consisting of the red-cyan filters and the EIZO CRT monitor will perhaps
give better 3D perception than that of the system consisting of the red-cyan filters and the
EPSON printer. And in fact in practice, this is correct.

6.3 Evaluation of MATLAB nonlinear optimization rou-
tines

In the previous and current chapter, there are situations where we want to find digital inputs
to the EIZO CRT monitor or the EPSON printer such that the left eye through the left filter
sees a desired color and the right eye through the right filter sees another desired color. This
problem can be solved using optimization techniques. With the EIZO CRT monitor, linear
optimizations such as the projection theorem can be used if the color distances are evaluated
in the CIE XYZ color space. However, if the device is the EPSON printer, where the whole

SFCF is a nonlinear function, then a nonlinear optimization must be involved.

As the work in this study was implemented in MATLAB, we concentrated on the nonlinear
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optimization routines that are available in the “Optimization Toolbox”. These routines are
fminsearch (which finds a minimum of a multivariables unconstrained scalar function using
the Nelder-Mead simplex method starting at an initial estimate), fminunc (which finds a
minimum of a multivariables unconstrained scalar function starting at an initial estimate),
fmincon (which finds a minimum of a multivariables constrained scalar function starting at
an initial estimate), lsqnonlin (which finds a minimum of a nonlinear least-squares problem
starting at an initial estimate. The optimal results might be subject to constraints), and
fminimaz (which finds a minimum of the worst-case value of a set of multivariable func-
tions, starting at an initial estimate. The optimal results might be subject to constraints)’.
However, since the inputs to the devices must be limited to the range [0, 1], thus only the
routines fmincon, lsqnonlin, and fminimaz will be examined as fminsearch and fminunc are

unconstrained routines.

To test these three routines, we set a test as follows: from the REDCAR stereo image pair
we follow Equations 5.14 and 5.15 for the LP method to create the left and right intended
images. We randomly pick 100 points on these images. At each of these points we want to
find an input to the EPSON printer so as to minimize the sum of two CIE XYZ Euclidean
distances between the left and right intended colors and the left and right perceived colors.
We use each of these three optimization functions to find the optimal results. These three
functions can only find local optimal results, thus they depend on the starting point to give
the correct optimal results. In this test, we use the values of the REDCAR anaglyph image
rendered by the LP method at those random points as the starting points. The number
of times that each routine gives the smallest objective value will be used to decide which
routine is better. Furthermore, to increase the confidence on the test, we also used a heuristic
Adaptive Simulated and Annealing (ASA) routine [29] to find the optimal result, as it is likely
that ASA will give the best global optimal solution.

In all 100 cases, the lsqnonlin routine didn’t yield any minimum objective value. The fmincon
routine yielded 95 out 100 times while the fminimaz routine had 97 times that it gave the
minimum objective values. As expected, the ASA routine gave the minimum objective
values at all 100 points. However, we won’t use the ASA routine in the study, because it is
extremely slow. During the test, fmincon called the objective function a total of 6394 times,
while fminimaz involved 9373 times. Thus fmincon is about 32% faster than fminimax.
Through this test we decided to use fminmaz as the nonlinear optimization. Figure 6.2

shows the graph of the objective function when the CIE XYZ tristimulus values of the left

!The information was taken from the MATLAB’s help. For more details on the usages of these routines
please refer to again the MATLAB’s help.
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objective value

Figure 6.2 Graph of the typical specified objective function when the CIE XYZ tristimulus

values of the left and right desired colors are (0.0220, 0.0095, 0.0001) and (0.0064, 0.0188,

0.0186) respectively and the coefficient B in the input to the EPSON printer is set to 0.2451.
The optimal result is (0.2633, 0.2910, 0.2451).

and right desired colors are (0.0220, 0.0095, 0.0001) and (0.0064, 0.0188, 0.0186) and the
coefficient B in the input to the EPSON printer is set to 0.2451. The optimal input is
(0.2633, 0.2910, 0.2451).

6.4 Search for a better anaglyph algorithm

As the LP method gives very good color stability and color fidelity for CRT displays, it is
natural to think of adapting it to printer media. The LP method tries to match the left and
right anaglyph perceived colors [Iar (A, x)] and [Iag(A,x)] with the original left and right
colors Iy, xyz(x) and Ig xyz(x), respectively. The values of the rendered anaglyph input
I4 rep(x) are often bigger than 1 because of the attenuation caused by colored-filter glasses.
By applying white-point normalization we can bring those values back in the range [0, 1].
For a printer, the nonlinear optimization method must replace the linear projection method
used in the LP method for a CRT display. As the printer’s SFCF is a nonlinear function
based on the interpolation technique, it can only return a valid estimated spectrum when
the inputs are in the appropriate range of [0, 1]. Therefore, if the nonlinear optimization
does not constrain the optimal results to the range [0, 1] then these optimal results will be
completely wrong and of course cannot be scaled down by the white-point normalization as
in the case of the CRT. However, if that constraint is included, then many optimal results
will often be at the boundary which is 1. As a result, the rendered anaglyph will have a lot
of white area. Therefore, the LP method cannot be applied directly for a printer.

The anaglyph images rendered for a CRT display have a pleasant appearance. Therefore,
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Figure 6.3 Anaglyph algorithm for a given printer block diagram.

instead of trying to find a new algorithm for a printer that works from the pair of two original
stereo images, we can reuse the result from the anaglyph algorithm specified for the CRT.
In other words, we want to render a printed anaglyph image such that it looks as close as
possible to the anaglyph image that is optimized for the CRT through the colored-filter glass
pair with minimum ghosting effect. This idea is like the idea of the gamut mapping between
the CRT and printer where the dichoptic color mixtures are the colors to be matched. The
advantage of this approach is that if the CRT display anaglyph algorithm is improved then

the anaglyph images rendered for printer are also improved.

6.5 A new anaglyph method for printer media

In this section we propose a novel method based on the idea presented above. Figure 6.3
shows a block diagram of the new method. It includes four modules: CRT anaglyph al-
gorithm module, Gamut Mapping (GM) module, Preprocessing module, and LRM module.
The first module, an anaglyph algorithm specified for CRTs, can be the LP method or the
method proposed in previous chapter. The purpose of this module is to create the left and
right CRT anaglyph intended images 174 rgp and Ira rgp from the original left and right-
perspective images Ir rgp and Ig rep by using Equations 5.14 and 5.15 for a given CRT

device. The next three modules are presented in following subsections.

6.5.1 Gamut Mapping module

The purpose of the GM module is to find the left printer anaglyph intended input i A.rRGB(X)
such that if it is printed onto a paper, then the left and right eyes will perceive colors
[TLAL()\,X)] and black respectively. We want to have [TLAL(/\,X)] close to Ipar xvz(x),
which is the color that the left eye perceives when viewing the left CRT intended input
I.4 rep(x). Similarly, we seek the right printer anaglyph intended input iRA’ reB(X) such
that if it is printed onto a paper, then the left and right eyes will perceive black and color
[Trar(),x)] respectively. Again, we want to have [Irar(), x)] close to Irar xvz(x), which is

the color that the right eye perceives when viewing the right CRT intended input Iga rep(x).
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Let iLAL,XYZ(X)a iLAR,XYZ(X), iRAL,XYZ(X), and iRAR,XYZ(X) be the CIE XY7Z tristimulus

values of the following four colors respectively

[TLAL()HX) = [YsFCF Printer <iLA,RGB(X)> ~fr(N)],
[zLAR(/\,X)] = [TSFCF,Printer %LA,RGB(X) 'fR()\)], (6.1)
[Irar (A, x)] = [Ysrer,printer (Lra,reB (X)) - fL(N)],
[TRAR()\:X)] = [Tsrcr,Printer iRA,RGB(X)> - frOV)],

where Tspcr printer 18 the printer’s SFCF2,

Obviously, the color error metric for measuring the above closeness cannot be color distance
between I;4z xyz(x) and iLAL,Xyz(X) or between Ipap xyz(x) and iRAR)(yz(X) as those
colors have different viewing conditions. Therefore, first we must convert those colors to
the same viewing condition by using either the chromatic adaptation model or the color
appearance model. We use the simplified Bradford model as the chromatic adaptation model
(Section 2.1.4.1) to find the CIE XYZ tristimulus values I 4z xvz adapted(X), as the chromatic
adaptation version of I a;, xyz(x), where the white point of the original viewing conditions is
the white point of the CRT monitor seen through the left colored-filter glass (|Ysrcr crr(|l1,
la, 13])-fr(N)]) and the white point of the adapting viewing conditions is the white point of
the paper seen through the left colored-filter glass ([Ysrcr printer (1, lo, 3])-fL(N)]). Here,
[l1, I, l3] is the result of Equation 5.18 with I pep(x) = [1, 1, 1].

Similarly, we want to find the CIE XYZ tristimulus values Irar xy 7z Adapted(X), as the chro-
matic adaptation version of Irag xyz(x) where the white point of the original viewing con-
ditions is the white point of the CRT monitor seen through the right colored-filter glass
(|Ysrer,crr(|r1, 72, 73])-fr(A)]) and the white point of the adapted viewing conditions is
the white point of paper seen through the right colored-filter glass ([Ysrcr printer([71, T2,
r3])-fr(A\)]), and where [ry, rq, 73] is the result of Equation 5.19 with I rep(x) = [1, 1, 1].

We would like to find the optimal solution iLA’RGB(X) to minimize the following objective

function

1.4 rGBOpt(X) = arg  min
Ip4,raB(X)

AEXyz(iLAnyz(X),ILAL,XYZ,Adapted(X)) (6 2)
+AExyz(1parxyz(x),0)

Similarly, we want to find the optimal solution in 4 ree(X) to minimize the following objective

2The EPSON printer’s SFCF was used in the study.
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function

IrareBopt(X) = arg  min
IrA,RGB(X)

AExyz(Iparxyz(X), Irar xv zAdapted (X)) (6.3)
+AExyz(Irar xvz(x),0)

The fminimaz routine is used here with the starting points being I 4 rep(x) and Iga rop(x),

respectively.

6.5.2 Preprocessing module

The purpose and the steps in this module are exactly the same as the Preprocessing module
described for the CRT monitor in Section 5.5.1. The differences are that we replace the
CRT’s SFCF Ygrcr,crr by the printer’s SFCF Tgpcr, printer and replace the monitor’s white
point by the printer’s white point®, when converting the CIE XYZ tristimulus values into
the CIELAB coordinates. Let izAL’XYZ(x) and i}%AR’XYZ(X) be the CIE XYZ tristimulus

values of the luminance adjusted colors I AL xyz(x) and iRAR’ xyz(X), respectively.

To convert i}AL’XYZ(X) to i*LA’RGB(X), we use the fminimaz routine to find the optimal input
i}A’RGB(x) to minimize the sum of AExy 7 between the color perceived by the left eye with
filter and color 17 4, xy(x) and AExyz between the color perceived by the right eye with
filter and black color. Similarly, to convert i*RAR,XYZ(X> to i}}A,RGB(X), we can use fminimaz
routine to find the optimal input i}}A’RGB(X) to minimize the sum of AExy, between the
color perceived by the right eye with filter and color i}‘z Arxyz(X) and AExyz between the
color perceived by the left eye with filter and black color. The effect of the parameters g, ¢y,
co, and c3 are the same as that for the proposed CRT display anaglyph algorithm.

6.5.3 LRM module

The LRM module here is similar to the one used in Section 5.4.1.1. Its purpose is to find
the final anaglyph image ij" rep(X) such that its left and right perceived colors T% L.xyz(X)
and ij‘R’XYZ(x) are close to the left and right intended colors i*LAL,XYZ(X) and i}‘MR’XYZ(x)
obtained from the previous module. We would like to find the optimal solution ijl, rap(X) to

minimize the following objective function

5, B )
IA,RGB,Opt (x) = arg ., mun
IA,RGB(X)

{ AEXYZ(iZL,Xyz(X):izAL,XYZ(X)) } (6.4)

+AExyz (iZR,XYZ (x), i*RAR,XYZ(X))

3Based on the measurement
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The starting point for the fminimaz routine can be set to (i}AvRGB (x) + i}}A’RGB(x)) :

6.5.4 Test results

To test the proposed algorithm, we used it to render three test stereo image pairs with the
parameter values set to g = 1, ¢c;= 0.2, co = 1, and ¢3 = 0.8 for the EPSON printer with
EIZO is the CRT device. Figures D.2, D.4, and D.6 are the printed version of REDCAR,
ICIP, and BEAR anaglyph images that are optimized for the EPSON printer. Figures D.1,
D.3, and D.5, whose softcopies are in Appendix C.10, are the printed version of REDCAR,
ICIP, and BEAR anaglyph images that are optimized for the EIZO CRT monitor using
the LP-Preprocessing-LRM1 algorithm proposed in Chapter 5. At the interesting regions
REDCARI, ICIP1, and BEARI, we can see that the ghosting effect is significantly reduced
for the EPSON printed versions compared with the EIZO printed versions.

6.5.5 Observations on the effect of different illuminant lights and
different photo-quality papers

The EPSON printer’s SFCF was established under illumination by incandescent light bulbs.
Therefore, under different illuminants the EPSON printer’s SFCF does not estimate the out-
put PDSs correctly. As a result, the rendered anaglyph images using this SFCF model under
different illuminants may not look as good as these anaglyph images under the incandescent
light bulbs. Fortunately, we verified that Figures D.2, D.4, and D.6 under the daylight and
fluorescent light look as good as under incandescent light bulbs, e.g., the ghosting effect is
very low, the color fidelity and stability are high. Therefore, the illuminant light does no

thave strong effect on the overall 3D perception.

We also used another photo-quality paper, different than the EPSON semigloss photo paper
used for modeling EPSON printer’s SFCF, to print the printer version ICIP anaglyph image.
The printed ICIP image looks as good as the one printed with the EPSON semigloss photo
paper. Therefore, different types of photo-quality papers may not affect too much the overall
3D perception. These results can save us from re-modeling new printers, which is a very
time-consuming process, under different illuminant lights or different types of photo-quality

papers.
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6.6 Summary

This chapter started with the discussion of why we cannot use the anaglyph algorithm that
is specified for a CRT display to render anaglyph images that would give good 3D perception
when they are printed on ordinary paper. A strong ghosting effect is the primary problem.
The reason for the strong ghosting in the EPSON printer is because of the strong dependency
between the PDS on the band B, and the PDS on the band Biz. We also showed a simple
test to quantify this dependency. Through the result of the test we see that the red-cyan
filter pair is better for the EIZO CRT monitor than for the EPSON printer. The chapter

also concluded that the MATLAB fminimaz optimization routine gives the best result.

Our recommendation for a method to render an anaglyph image when printed on a paper
from a given stereo image pair is as follows: first use the LP method to render the left
and right intended images for a given CRT display. Then convert these two images for the
given printer. Apply the Preprocessing steps to modify the luminance of these two intended

images. Finally use the LRM method to find the final anaglyph image.



CHAPTER
SEVEN

Conclusions

7.1 Overview of findings

The aim of this thesis was to develop methods for rendering anaglyph images which are
displayed on a CRT display or printed on paper to give best 3D perception. This was
done by presenting the background (Chapter 2) on color theory and the characterization
of two popular color display device types: CRT displays and printers. The color theory
review included the colorimetric color space which is a three-dimensional vector space, with
the CIE XYZ color space as its most popular representative, and color appearance model
which is based on the color attributes (hue, brightness, lightness, colorfulness, chroma, and
saturation) rather than the quantified visible light stimuli, with the CIELAB color space as its
representative. The characterization process review presented a generic way of establishing
SFCFs of a CRT display and a printer. SFCF is the relationship between the device digital
input, which is also considered as color device-dependent representation, and the PDS of the

emitting or reflecting spectrum from the characterized device.

Chapter 3 contained a literature survey on existing anaglyph algorithms. It formulated the
anaglyph problem which is used as the framework for the later chapters. The condition of
colored-filter glasses was also described. Through the formulation, the quality factors of an
anaglyph algorithm can be classified as: color stability, which indicates stability of the overall
perceived dichoptic color mixtures, color fidelity, which indicates how large the gamut of the
perceived dichoptic color mixtures is, and ghosting effect, which is the leaking information of
one perspective image into the other eye. There were only a few existing anaglyph algorithms
and they are Photoshop, Midpoint, LP, and ColorCode methods. The Photoshop method in
general gives strong color rivalry. The Midpoint method gives a poor 3D perception. The LP
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method gives stable perceived colors with good color fidelity. Its rendered anaglyph images
are very comfortable to view. However, one drawback of the LP method is that it gives a
strong ghosting effect. The ColorCode method is primarily used for the yellow-blue filter
pair. Since the yellow-blue filter pair exhibits strong imbalance of luminances between the
two eyes; therefore, ColorCode method suffers from a strong luminance imbalance between
left and right eyes. This limitation makes the rendered anaglyph images uncomfortable to
view. The advantage of the ColorCode method lies with greater color fidelity (e.g. the red
color can be perceived by the yellow-blue filters while it is very hard to see the red color

through the red-cyan filters).

The SFCFs of color display devices used in this study were described on Chapter 4, specif-
ically for the EIZO CRT monitor and the EPSON Stylus Photo 2200 printer. The EIZO’s
SFCF is established based on the model-based approach, whereas, the SFCF’s EPSON
printer is based on the empirical approach in which a satisfactory solution was found by

using the order-5 polynomial regression.

The new anaglyph algorithm which is optimized for a CRT display was presented in Chapter
5. It is an enhancement of the LP method. The limitation of the LP method lies with its
ghosting effect. Through a simple experiment we have been able to see that for the red-
cyan filters and yellow-blue filters, the perceived dichoptic color mixtures are very close to
either the monoptic colors that are perceived by the left or right eyes, and hence we cannot
reproduce the original colors. The result from this experiment couples with the fact that the
LP method gives very good color fidelity and color stability suggested that it is likely that
we cannot improve the color stability and color fidelity. Therefore, the developed method
focused on reducing the ghosting effect limitation in the LP method. In order to do this, a
new ghosting definition was defined. It can be applied at a single pixel for a given algorithm.
Based on this definition, a new method was derived and consisted of the following steps: first
finding the left and right anaglyph intended images using the LP method, then adjusting the
luminances of these left and right anaglyph intended images (Preprocessing algorithm), and
finally using the linear optimization to find the anaglyph image that gives the left perceived
image close to the left anaglyph intended image and the right perceived image close to the

right anaglyph intended image (LRM algorithm).

The anaglyph images to be printed on a paper to give good 3D perception cannot be rendered
using the algorithms that are intended for a CRT display as the ghosting effect will be
magnified in the printed version. This is mostly due to the strong dependency between the

reflecting PDSs from the paper perceived by the left and right eyes through filters. A simple
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method has been shown to capture this dependency, and it suggested that the dependency
of the EIZO CRT monitor is much lower than that of the EPSON printer. The proposed
anaglyph algorithm optimized for printer was presented in Chapter 6. It consisted of the
following steps: first finding the CRT left and right anaglyph intended images by using the
LP method, then mapping these two images into printer’s gamut to obtain the printer left
and right anaglyph intended images, next adjusting the luminance of these two images, and

finally using the nonlinear optimization to find the final anaglyph image.

The test results from three stereo image pairs have shown that the novel anaglyph algorithm
for a given CRT display renders anaglyph images that exhibit much lower ghosting effects
than these rendered by the LP method and yet give a good color stability and color fidelity.
The test results also revealed that the novel anaglyph algorithm for a given printer renders
anaglyph images which when printed on ordinary paper exhibit much lower ghosting effects
than the printed versions of the anaglyph images rendered for a given CRT display. Although
the novel ghosting definition can be used to measure numerically the ghosting effect on each
eye, however, the overall quality of an anaglyph algorithm can only be judged by a human.
This means that the comparison between two algorithms must be drawn from a large number
of observers and a large set of rendered anaglyph images. However, all the observations in

this study were made primarily by two people, one of them the author of the thesis.

7.2 Contributions of the thesis

The novel contributions of this thesis are as follows:

1. Introduced a novel way of measuring numerically the ghosting effect. This novel

method can be applied at a single pixel for a given anaglyph algorithm.

2. Developed a novel anaglyph algorithm used to render anaglyph images for a given CRT
display. This novel algorithm uses the LP method to find the left and right anaglyph
intended images, then adjusts the luminances of these left and right anaglyph intended
images, and finally uses the linear optimization to find the anaglyph image. The test
results have shown that the new rendered anaglyph images had much less the ghosting
effect than those anaglyph images rendered by the LP method without sacrificing much
the color stability and the color fidelity.

3. Developed a novel anaglyph algorithm used to render anaglyph images for a given
printer. This novel algorithm uses the LP method to find the CRT left and right
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anaglyph intended images, then maps these two images into the printer’s gamut to ob-
tain the printer left and right anaglyph intended images, next adjusts the luminance of
these two images, and finally uses the nonlinear optimization to find the final anaglyph
image. The test results have shown that the ghosting effect was reduced significantly
for the printed versions of the anaglyph images rendered by the novel algorithm com-
pared with the printed versions of the anaglyph images rendered by the novel anaglyph
algorithm for a given CRT display.

4. Formulated the anaglyph problem from a mathematical point of view and established

the condition for colored-filter glasses.

5. Proposed a novel method to check the compatibility between a colored-filter glass pair

and a color output device.

Besides these main contributions, a significant amount of work has been done for measuring

the spectra and modeling the devices” SFCFs. Specifically:

1. Measured the PDS of three primaries of the EIZO CRT monitor, and based on these
measurements, established its SFCF using the model-based approach. The parameter
values for the GOG gamma-correction model for the EIZO CRT monitor were also

calculated based on 30 measurements of the PDSs of the emitting lights.

2. Measured the PDS of lights reflecting from 840 different colorant mixtures that were
printed using the EPSON printer. Based on these measurements, established its SFCF

using the order-5 polynomial regression technique.

7.3 Future work

For the future work, more sophisticated appearance color spaces such as CIECAMO02 and its
color distance metric errors may be used to replace the CIE XYZ Colorimetric model used
in LRM-1, LRM-2, or the printer anaglyph algorithm developed in Chapter 6, or replace the
CIELAB color space used in the Preprocessing algorithm. So far, only the Preprocessing
algorithm uses global information (which is the maximum luminance difference between the
left and right anaglyph intended images) in the calculation while all other calculations are
carried out independently at each sample point. Therefore, in future work, we can investigate
more about the effect of the neighbor points. The current speed of rendering an anaglyph
image for a printer is extremely slow. Thus, we can further optimize the code to increase the
rendering speed, such as converting the MATLAB code into C code or find faster nonlinear

optimization methods.



REFERENCES

[1] G. Sharma, Digital Color Imaging Handbook. New York, NY: CRC Press, 2003.

[2] E. F. Glynn. (2005, Feb.) Chromaticity diagrams lab report. [Online]. Available:
http://www.efg2.com /Lab/Graphics/Colors/Chromaticity.htm

[3] L. Lipton. (1997) Stereographics developers’ handbook. Stereographics Corporation.
[Online|. Available:  http://www.stereographics.com /support/downloads support/
handbook.pdf

[4] T. Motoki, H. Isono, and I. Yuyama, “Present status of three-dimensional television
research,” in Proc. IEEFE, vol. 83, no. 7, July 1995, pp. 1009-1021.

[5] S. Volbracht, K. Shahrbabaki, G. Domik, and G.Fels, “Perspective viewing, anaglyph
stereo or shutter glass stereo?” in Proc. IEEE Symposium on Visual Languages, Boulder,
CO, Sept. 1996, pp. 192-193.

[6] E. Dubois, “Chapter 3 - light and color,” ELG5378 Course Notes, SITE, University Of
Ottawa, 2004.

[7] M. D. Fairchild, Color Appearance Models. Reding, Massachusetts: Addison-Wesley,
1998.

[8] G. D. Finlayson and S. Siisstrunk, “Spectral sharpening and the Bradford transform,”
in Proc. CIS 2000, 2000, pp. 236-243. |Online|. Available: http://ivrgwww.epfl.ch/
publications/fs00a.pdf

[9] H. R. Kang, Color Technology for Electronic Imaging Devices. ~Washington: SPIE
Press, 1997.

[10] International color consortium. [Online]. Available: http://www.color.org/

[11] R. Berns, “Methods for characterizing CRT displays,” Displays, vol. 16, no. 4, pp. 173~
182, 1996.

[12] D. Post and C. Calhoun, “Further evaluation of methods for producing desired colors
on CRT monitors,” Color Research € Application, vol. 25, no. 2, pp. 90-104, Feb. 1999.

91



92 REFERENCES

[13] R. Berns, A. Bose, and D. Tzeng, “The spectral modeling of large-format ink-jet print-
ers,” Dec. 1996.

[14] M. Stokes, M. Anderson, S. Chandraseka, and R. Motta. (1996, Nov.) A standard default
color space for the internet - srgb. [Online|. Available: http://www.w3.org/Graphics/
Color/sRGB

[15] J. Hovis and S. Guth, “Dichoptic opponent hue cancellations,” Optometry € Vision
Science, vol. 66, no. 5, pp. 304-319, 1989.

[16] E. Dubois, “A projection method to generate anaglyph stereo images,” in Proc. IEEE
Int. Conf. Acoustics Speech Signal Processing, vol. 3, 2001, pp. 1661-1664.

[17] S. Sorensen, P. Hensen, and N. Sorensen, “Method for recording and viewing stereoscopic
images in color using multichrome filters,” U.S. Patent 6 687 003, Feb. 03, 2004.

[18] A. Woods and T. Rourke, “Ghosting in anaglyph stereoscopic images,” in Proc. SPIE
Stereoscopic Displays and Virtual Reality Systems X1, vol. 5290, Feb. 2004, pp. 354-365.

[19] R. Turnnidge and D. Pizzanelli, “Methods of pre-visualizing temporal parallax suit-
able for making multiplex holograms. Part II: Greyscale and colour anaglyphs made in
Photoshop.” Imaging Science Journal, vol. 45, no. 1, pp. 43—44, 1997.

[20] M. Suto. (2005, May) Stereophoto maker. [Online|. Available: http://stereo.jpn.org/
eng/stphmkr/

[21] T. Sekitani. (2004) Stereo eye. [Online|. Available: http://www.stereoeye.jp/software/
index e.html

[22] E. Monneret and D. Leboutte. (2005, Oct.) Anabuilder. [Online|. Available: http://
anabuilder.free.fr /welcomeEN.html

[23] W. Sanders and D. McAllister, “Producing anaglyphs from synthetic images,” in Proc.
SPIE Stereoscopic Displays and Virtual Reality Systems X, vol. 5006, May 2003, pp.
348-358.

[24] A. Mertens, Signal Analysis. Wavelets, Filter Banks, Time-Frequency Transforms and
Applications. Chichester, UK: John Wiley & Sons, 1999.

[25] New art illusion. [Online|. Available: http://www.3d-easy.de/EN/Produkte/Software/
software.html

[26] L. Taplin, “Spectral modeling of a six-color inkjet printer,” Master’s thesis, University
of Delaware, Dec. 2001.

[27] Berezin stereo photography products. [Online]. Available: http://www.berezin.com/3d/
Optio3DViewer.htm



REFERENCES 93

[28] J. Konrad, B. Lacotte, and E. Dubois, “Cancellation of image crosstalk in time-
sequential displays of stereoscopic video,” IEEE Trans. Image Process., vol. 9, no. 5,
pp- 897-908, May 2000.

[29] S. Sakata. (2005, Aug.) ASAMIN. [Online|. Available: http://www.econ.ubc.ca/
ssakata/public _html/software/

[30] USB2000 Fiber Optic Spectrometer Operating Instructions, Rev 2.05 ed., Ocean Optics
Inc, 380 Main Street, Dunedin, Fla., USA, Nov. 2003.

[31] OOIBase32 Spectrometer Operating Software Operating Instructions, Rev 2.22 ed.,
Ocean Optics Inc, 380 Main Street, Dunedin, Fla., USA, May 2004.






APPENDIX
A

Ocean Optics USB2000

THIS APPENDIX SUMMARIZES the usage of the Ocean Optics USB2000-VIS-NIR spectrom-
eter. In this study, it is used to measure the PDS of light emitting from a CRT display,
the PDS of light reflecting from a colorant mixture printed by a printer, and the spectral
absorption curve of a colored-filter glass. All the information in this appendix is taken from
references |30, 31].

A.1 Introduction

In general, a spectrometer is an instrument that measures the intensity of radiation as a
function of wavelength and can be used to measure both emissive and reflective light, whereas
the spectrophotometer can only measure the reflective light. USB2000-VIS-NIR is a small
size spectrometer (89 mm x 64 mm x 34 mm LWH) with two connections: the USB port
used communicate with a PC (also used as power source) and the SMA fiber optic connector
as entrance aperture used to connect sampling accessories that filter light into the USB2000.
In this research, the USB2000 is preconfigured by the manufacturer to have grating #3,
OFLV-350-850 order sorting filter, 23 micron slit entrance aperture, and optical resolution
1.5 micron. It is capable of measuring light with wavelength in the range of 200nm-1100nm
and its resolution is 0.3 - 10.0 nm. For its other features please refer to its instruction

manual [30].

The Ocean Optics O0IBase32 is a program used to communicate with the USB2000. It
receives the measured spectral data from the USB2000 and plots it onto the monitor screen in
real time. For installation steps and the configurations to work with the USB2000 please refer

to Section 2 in its instruction manual [31]. Depending on the type of measuring (emittance,
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reflectance, or absorbent), the USB2000 needs different type of sampling accessories. Each
sampling accessory gathers and transmit a certain amount of light into the USB2000. Besides
that, we need a light source to act as a black body with a known temperature. The reason
for this is that USB2000 itself is a light photon to voltage converter. The signal generated
from the USB2000 due to stimuli is just the raw voltage values at different wavelength but
not the real spectrum of the measuring light. In order to convert the raw voltage data into
the meaningful light PDS, the OOIBase32 compares the measured raw voltage data with
the raw voltage data caused by a blackbody light source. The PDS of a black body can
be generated from its body’s temperature. Here, we use the Ocean Optic LS-1 Tungsten
Halogen light source with it’s body temperature of 3100 K and its spectral range of 360 nm
- 2500 nm.

A.2 Settings

There are a few important settings in OOIBase32 needed to be set before conducting any
experiment. The value in the “Integ. Time” box indicates the amount of time (in ms) which
the USB2000 lets the light’s photons to come inside the box. Always try to adjust the
integration time to have the raw voltage signal at its peak of about 3500 counts. The value
of the “Average” box indicates the number of measurements of the raw voltage data of the
same stimuli light. The average of these measurements is the final raw data. The value in
“Boxcar” box, for instance 5, indicates a raw voltage at a specific wavelength is the average

of 5 adjacent points to its left and 5 adjacent points to its right.

A.3 Steps for measuring colored-filter glass’s absorption

curve

Apparatuses used to measure the colored-filter glass’s absorption curve consists of: spec-
trometer USB2000, configured OOIBase32 software, LS-1 light source, and Ocean Optics
CC-3-DA Direct-attach Cosine Corrector light sampling accessory. Figure A.1 illustrates
the set up. Before starting the measuring process, OOIBases32 is needed to be configured
as follows: set the value in the “Integ. Time” box to 1000, the value in the “Average” box
to 3, and the value in the “Bozcar” box to 5. The following are the steps for measuring an

absorption curve:

1. Attach the CC-3-DA Direct-attach Cosine Corrector to the USB2000.
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Figure A.1 The set up for measuring colored-filter glass’s absorption curve.

2. Set OOIBase32 in scope mode by clicking the "Scope Mode" button on the tool bar,

or by selecting “Spectrum > Scope” mode from the menu bar.

3. Turn on the LS-1 light source and let it warm up for about 10 minutes. Now place the
CC-3-DA in front of the LLS-1 to measure the light source PDS. Adjust the distance
between the USB2000 and the light source to have the intensity signal of light source
about 3500 counts. Click the "Store Reference” spectrum icon on the toolbar or select
“Spectrum > Store Reference” from the menu bar to store the reference. (Note we can
save this reference spectrum for future use by select “File > Save > Reference” from

the menu bar to permanently save this spectrum to hard disk for later reuse).

4. Block any light coming to the USB2000, but be careful not to move the USB2000.
Then, take a dark spectrum by clicking the "Store Dark Spectrum" icon on the toolbar
or by selecting “Spectrum > Store Dark” from the menu bar. (Note we can save this
dark spectrum for future use by select “File > Save > Dark” from the menu bar to

permanently save this spectrum to hard disk for later reuse).

5. Click on "Spectrum > Reference Color Temperature” and enter 3100 into the box (note
3100 is the temperature of the black body light source LS-1).
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Figure A.2 The set up for measuring emitting light PDS from a monitor.

6. Click on the "Transmission” mode icon on the toolbar or select "Spectrum > Trans-

maission Mode” from the menu bar.

7. Place the colored-filter glass in front of the CC-3-DA and wait for about 6 seconds to
let the signal stabilize.

8. Save the transmission curve to the hard disk by clicking the “save” icon on the toolbar
or select "File > Save > Processed” from the menu bar (please refer to Appendix C

in the reference [31, pg.69] for an example of the saved file format).

9. Finally, interpolate the saved data into the designed wavelength range (e.g. in the
range of 400 nm - 700 nm with the interval of 2nm for this research) (in MATLAB,

the function interp! can be used).

A.4 Steps for measuring emitting light PDS from a mon-
itor

Apparatuses used to measure the emitting light from a monitor consists of: spectrometer
USB2000, configured OOIBase32 software, LS-1 light source, and Ocean Optics CC-3-DA
Direct-attach Cosine Corrector light sampling accessory. Figure A.2 illustrates the set up.

Before starting the measuring process, OOIBases32 is needed to be configured as follows:
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set the value in the “Integ. Time” box to 2000, the value in the “Average” box to 3, and

the value in the “Boxcar” box to 5. The following are the steps for measuring emitting light

PDS:

1.

2.

10.

Attach the CC-3-DA Direct-attach Cosine Corrector to the USB2000.

Set OOIBase32 in scope mode by clicking the "Scope Mode" button on the tool bar,

or by selecting “Spectrum > Scope” Mode from the menu bar.

Turn on the LS-1 light source and let it warms up for about 10 minutes. Now place
the CC-3-DA in front of the LS-1 to measure the light source. Adjust the distance
between the USB2000 and the light source to have the intensity signal of light source
about 2000 counts. Click the "Store Reference” spectrum icon on the toolbar or select
“Spectrum > Store Reference” from the menu bar to store the reference. (Note we can
save this reference spectrum for future use by select “File > Save > Reference” from

the menu bar to permanently save the spectrum to disk for later reuse).

Block any light coming to the USB2000. Then, take a dark spectrum by clicking the
"Store Dark Spectrum” icon on the toolbar or by selecting “Spectrum > Store Dark”

from the menu bar.

Click on "Spectrum > Reference Color Temperature" and enter 3100 into the box (note
3100 is the temperature of the black body light source LS-1).

Click on the "Irradiance” mode icon on the toolbar or select "Spectrum > Relative

Irradiance Mode” from the menu bar.

Make the monitor to display a desired color in large enough area. Then, place the
CC-3-DA in front of this color (let the CC3 touch the monitor screen gently to reduce

the flare effect) and wait for about 12 seconds to let the signal stabilize.

Save the spectrum to hard disk by clicking the "save” icon on the toolbar or select
"File > Save > Processed” from the menu bar (please refer to Appendix C in the

reference |31, pg.69| for an example of the saved file format).

Interpolate the saved data into the designed wavelength range (e.g. in the range of 400
nm - 700 nm with the interval of 2nm for this research) (in MATLAB, the function

interpl can be used).

Finally, normalize the interpolated spectrum by scaling down the whole spectrum by
the value of the luminance of the brightest point generate by the monitor (Section
2.2.3). This brightest point is the monitor white.
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Figure A.3 The set up for measuring reflecting light PDS from a paper.

A.5 Step for measuring reflecting light PDS from a paper

Apparatuses used to measure the reflecting light from a paper consists of: spectrometer
USB2000, configured OOIBase32 software, LS-1 light source, Ocean Optics R200-7-VIS-NIR
reflection probe 200 micron light sampling accessory, RPH-1 probe holder, and illuminant
light source (in this study we used the commercial 60W incandescent light bulb). Figure
A.3 illustrates the set up. The R200-7-VIS-NIR has three legs. The illumination leg, which
has the SMA 905 connector and big fiber diameter, is used to connect to the light source
such as LS-1. The read leg, which has the SMA 905 connector and small fiber diameter if
compared with the illumination leg, is used to connect to the USB2000. And the probe leg,
that has no connector, is used to collect the reflecting light. Basically, the illumination leg
will transmit the light from the light source to the probe to illuminate the object through
the illumination fiber. The reflecting light is then collected by the probe and is transmitted
to the read leg through the read fiber and then to the USB2000.

Let Ineasured (A) and Syeasurea(A) be the measured raw voltage signal of the illuminant light

and the reflecting light, respectively. Let Tgreadriber(A) and YiuminationFiber(A) be the atten-
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uation functions of the read and illumination fibers, respectively. We have

[Measured()\) = [()\) : TReadFiber()\)a (Al)
SMeasured()\) = I()\) : TIlluminationFiber()\) : Ref()\) : TReadFiber()\)- (AQ)

where I(\) is the PDS of the illuminant light and Ref(\) is the spectral reflectance of a

colorant mixture. From Equations A.1 and A.2, we can find Ref(\) as

_ SMeasured ()\)
[Measured ()\) : TIlluminationFiber ()\) ‘

Ref()) (A.3)
Therefore, we need to obtain the function Yiuminationriber(A). This function was extracted
from the R200-7-VIS-NIR’s specifications. Once Ref(\) is obtained, a reflecting light PDS
S(A) can be calculated as
I'(A) - Ref (M)
3 )
where I'()) is the PDS of an arbitrary illuminant light and k is the luminance value of the
color Swhite(A) = I'(A)-Ref white (A), With Ref wpie (M) is the spectral reflectance of the plain
paper. The PDS I’(\) can be measured by following the steps in Section A.4 except that,

we place the CC-3-DA in front of the light source in the step #5 and skip the step #10.

S() = (A.4)

Before starting to measure Syeasured (), the OOIBases32 is need to be configured as follows:
set the value in the “Integ. Time” box to 200, the value in the “Average” box to 3, and the

value in the “Bozcar” box to 5. The following are the steps for measuring Syfeasured (A):

1. Attach the read leg of the R200-7-VIS-NIR to the USB2000 and the illumination leg
of R200-7-VIS-NIR to the LS-1.

2. Set OOIBase32 in scope mode by clicking the "Scope Mode"” button on the tool bar,

or by selecting “Spectrum > Scope” Mode from the menu bar.

3. Block any light coming into the illumination and read legs. Then, take a dark spectrum
by clicking the "Store Dark Spectrum” icon on the toolbar or by selecting “Spectrum

> Store Dark” from the menu bar.

4. Place the read leg 45 degree with the printed colorant mixture and about to touch
the paper using the RPH-1 probe holder. Wait for about 5 seconds to let the signal

stabilize.

5. Save the spectrum to hard disk by clicking the "save” icon on the toolbar or select
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"File > Save > Processed” from the menu bar (please refer to Appendix C in the

reference |31, pg.69| for an example of the saved file format).

6. Interpolate the saved data into the designed wavelength range (e.g. in the range of 400
nm - 700 nm with the interval of 2nm for this research) (in MATLAB, the function

“interp1” can be used).
The following are the steps for measuring Iyjeasured (A):

1. Attach the read leg of the R200-7-VIS-NIR to the USB2000. Cover the illumination
leg of the R200-7-VIS-NIR so that there is no light to get into it.

2. Set OOIBase32 in scope mode by clicking the "Scope Mode" button on the tool bar,

or by selecting “Spectrum > Scope” Mode from the menu bar.

3. Block any light coming into the read leg. Then, take a dark spectrum by clicking the
"Store Dark Spectrum” icon on the toolbar or by selecting “Spectrum > Store Dark”

from the menu bar.

4. Turn on the LS-1 Light source and let it warms up for about 10 minutes. Now place
the read leg in front of the LS-1 to measure the spectrum of light source. Adjust the
distance between the read leg and the light source to have the intensity signal of light
source about 3000 counts. Click the "Store Reference"” spectrum icon on the toolbar or
select “Spectrum > Store Reference” from the menu bar to store the reference. (Note
we can save this reference spectrum for future use by select “File > Save > Reference”

from the menu bar to permanently save the spectrum to disk for later reuse).

5. Interpolate the saved data into the designed wavelength range (e.g. in the range of
400 nm-700 nm with the interval of 2nm for this research) (in MATLAB, the function

“interp1” can be used).
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Test stereo image pairs

B.1 Test stereo image pairs

Three stereo image pairs (REDCAR, ICIP, and BEAR) have been used to test to the quality
of an anaglyph algorithm. REDCAR, (Figure B.1) was acquired by an IMAX stereoscopic film
camera and the output was scanned at high-resolution and downsampled to size 720x576.
ICIP (Figure B.2) represents the logo of the International Conference on Image Processing.
It has the size of 1024x1024. The stereo image pair was generated from a 3D model created
with Maya by Eric Wellman. BEAR (Figure B.3) is cropped from one stereo frame of the
2002 3D computer graphics movie SOS Planet produced by NWave picture. It has the size

of 401x401. The electronic versions of these images are in Appendix C.1.
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(a) Left-perspective image (b) Right-perspective image

Figure B.1 REDCAR stereo image pair (electronic versions in Appendiz C.1).

(a) Left-perspective image (b) Right-perspective image

Figure B.2 ICIP stereo image pair (electronic versions in Appendiz C.1).
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(a) Left-perspective image (b) Right-perspective image

Figure B.8 BEAR stereo image pair (electronic versions in Appendiz C.1).

B.2 Interesting regions

From Section 3.2.1.3, an anaglyph algorithm can be judged through three quality factors:
ghosting effect, color stability, and color fidelity. Each of those three stereo images pairs has
some interesting regions which we would like to pay particular attention to. These interesting
regions exhibit the color stability and ghosting effect quality factors of an anaglyph algorithm.
The interesting regions REDCAR3 and ICIP1 allow us to examine the ghosting effect of
an anaglyph algorithm. The interesting regions REDCAR1 and REDCAR2 give us the
judgment about the color stability. However, the overall quality of the rendered anaglyph
images allows us to judge the color fidelity as well as the color stability of an anaglyph

algorithm.
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Figure B.4 REDCAR interesting regions.

Figure B.5 (a) The ICIP1 interesting region and (b) the BEARI interesting region.
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Electronic Appendix

A CD 18 INCLUDED with the thesis. This CD is used to store the anaglyph images that
are rendered by different anaglyph methods, the transmission absorption curves of some
selected colored-filter glasses, the white point normalized PDS of the EIZO CRT monitor’s
primaries, and the reflectance curves of colorant mixtures printed by the EPSON printer.
This appendix explains the structure of the CD. Each file in the CD has a companion text

file that explains its intention.

C.1 “Test stereo image pairs” folder

This folder contains the ICIP, BEAR, and REDCAR stereo image pairs.

C.2 “EIZO CRT Spectra” folder

This folder contains the spectra of the primaries emitted from the EIZO CRT monitor.

C.3 “EPSON Printer Spectra” folder

This folder contains the reflectance curves of colorant mixtures printed by the EPSON

printer.

C.4 “Glass Transmission Absorption Curves” folder

This folder contains the transmission absorption curves of different colored-filter glasses.
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C.5 “Photoshop Anaglyph Images” folder

This folder contains the anaglyph images rendered by the Photoshop method for the EIZO
CRT monitor.

C.6 “Midpoint Anaglyph Images” folder

This folder contains the anaglyph images rendered by the Midpoint method for the EIZO
CRT monitor.

C.7 “LP Anaglyph Images” folder

This folder contains the anaglyph images rendered by the LP method for the EIZO CRT

monitor.

C.8 “LRM-1 Anaglyph Images” folder

This folder contains the anaglyph images rendered by LRM-1 based on the LP method for
the EIZO CRT monitor.

C.9 “LRM-2 Anaglyph Images” folder

This folder contains the anaglyph images rendered by LRM-2 based on the LP method for
the EIZO CRT monitor.

C.10 “Preprocessing Anaglyph Images” folder

This folder contains the anaglyph images rendered by LRM-1 based on the LP method with
the Preprocessing process for the EIZO CRT monitor.
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Anaglyph images rendered on the EPSON printer

THIS APPENDIX CONTAINS three anaglyph images that are rendered from three test stereo
image pairs by using the novel algorithm proposed in Chapter 6 for the EPSON printer
whose Ysper printer () has been established in Chapter 4. Figure D.1 (whose softcopy is in
Appendix C.10) is the printed version of the REDCAR anaglyph image that is optimized for
the EIZO CRT monitor using the LP-Preprocessing-LRM1 algorithm proposed in Chapter
5. Figure D.2 is the printed version of the REDCAR anaglyph image that is optimized
for the EPSON printer. Figure D.3 (whose softcopy is in Appendix C.10) is the printed
version of the ICIP anaglyph image that is optimized for the EIZO CRT monitor using
the LP-Preprocessing-LRM1 algorithm proposed in Chapter 5. Figure D.4 is the printed
version of the ICIP anaglyph image that is optimized for the EPSON printer. Figure D.5
(whose softcopy is in Appendix C.10) is the printed version of the BEAR anaglyph image
that is optimized for the EIZO CRT monitor using the LP-Preprocessing-LRM1 algorithm
proposed in Chapter 5. Figure D.6 is the printed version of the BEAR anaglyph image that
is optimized for the EPSON printer. We can see that the ghosting effect is significantly

reduced in all these images with the algorithm optimized for the printer.
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